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Volume 1
IMPRINT Pro Basic Procedures
Chapter 1: Introduction

The Improved Performance Research Integration Tool (IMPRINT) was 
developed for the Army Research Laboratory (ARL) Human Research and 
Engineering Directorate (HRED). This manual describes the professional 
version of IMPRINT, named IMPRINT Pro. IMPRINT Pro is government-
owned and consists of a set of automated aids to assist analysts in 
conducting human performance analyses. IMPRINT Pro provides the 
means for estimating manpower, personnel, and training (MPT) 
requirements and constraints for new weapon systems very early in the 
acquisition process.

Some of the key features of IMPRINT Pro are:

Includes extensive MPT data libraries on existing weapon 
systems

Estimates operator and maintainer manpower requirements at 
the system, unit and force levels

Provides task-based analyses that predict changes in 
performance as a function of changes in personnel 
characteristics

Predicts performance effects of environmental stressors and 
sustainment training frequency

Estimates crew workload

Contains mission simulation models that aggregate task 
performance 

ARL HRED distributes IMPRINT Pro. For more information about IMPRINT 
Pro or to obtain a copy of IMPRINT Pro, please contact imprint-
info@arl.army.mil.
1
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What’s New in this Manual

The following list describes new features and enhancements to look for in 
this version of IMPRINT Pro:

Database-less installation:  this version of IMPRINT Pro is 
database-less, resulting in easier installation, updating and 
uninstallation of the application.  Because data is stored as 
separate .xml files rather than inside a database, analyses are 
quicker and easier to import, export and backup and require less 
space on your system overall.

MMF Mission Builder:  this separate application allows you to 
create the basic framework of a mission (tasks, functions, goals, 
operators) in an external application.  This application is geared 
towards MMF users and uses the MMF terminology.  It can, 
however, be used to create a generic IMPRINT Pro (i.e., non-
MMF) mission as well.

Task Sequence Chart:  The Task Sequence Chart displays all 
task activity that occurred during a model run in the form of a 
Gantt chart.

Mission Time Drivers chart: This chart displays a subset of 
information contained by the Task Seqence Chart, specifically 
those tasks which contribute to the critical path of the mission. 
and Task Sequence Chart.  All task data displays in a Gantt 
chart format.

Task Network Exporting:  export your entire task network to 
Microsoft Excel as a table.

Remote and Local Server Setup:  share analysis files between 
one or more machines over a common network.

Disable Reports Option: temporarily disable reports to bypass 
post-processing time.  By disabling the reports the simulation 
clock time and duration of the model run may be immediately 
viewed in the output window once the model run completes.

Personnel Forecast Report (previously Personnel 
Attributes):  For every operator in your analysis having a unique 
specialty, the Personnel Forecast Report displays the number of 
people of that specialty who will be available over the course of 
the next five years. Estimates are broken down by E-level (E3, 
E4...E9).
2



Chapter 1: Introduction
Specialty Utilization Report (for Operations, Maintenance 
and Forces): For users who regularly use the Army Military-
Civilian Cost System (AMCOS) to estimate the cost of using a 
fixed number of military personnel for a specific number of years, 
the Specialty Utilitization Report is designed to provide you 
information about the utilization of all the specialties in your 
model run which may then be used as a basis for the data you 
enter into AMCOS.

Network Workload Monitors:  in addition to the Animator 
window, workload monitoring may now be done directly in the 
Network Diagram window by adding workload monitors as 
desired.  The workload totals displayed by the monitors update 
as the simulation progresses.

Charts: chart the values of variables at run-time.  Variables can 
be plotted against other variables.

Custom Training Moderators: Now besides adding your own 
custom stressors to your model, you can also add custom 
training to impact task performance.

Revised Workload Strategies: the previous workload strategies 
of E and F (reallocation of new task and reallocation of ongoing 
task to contingency operator) has now been combined to a new 
strategy E.  This strategy has been enhanced by a new 
dropdown list which now not only allows you to choose either the 
new task or an ongoing task to get reallocated but among all 
ongoing tasks, namely by highest priority, lowest priority, highest 
difficulty, lowest difficulty and by how recently the task was 
added relative to other tasks.

About this Manual

The IMPRINT Pro User Guide contains the following volumes, chapters, 
and glossaries:

Volume 1— IMPRINT Pro Basic Procedures

Chapter 1 Introduction

This chapter contains an overview of IMPRINT Pro, lists the contents of the 
guide, explains how to use the online help feature, and outlines the 
conventions used in documentation.
3
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Chapter 2 Installing IMPRINT Pro

This chapter describes system requirements and how to install and start 
IMPRINT Pro.

Chapter 3 Understanding IMPRINT Pro Analyses

This chapter describes the various elements of a IMPRINT Pro analysis. 
Sections are arranged around conducting analyses of system missions and 
equipment. This chapter includes descriptions of the IMPRINT Pro 
interfaces, data collection, and analysis features. The chapter concludes 
with a general discussion of the steps involved in creating, debugging, and 
running IMPRINT Pro analyses.

Chapter 4 Understanding the IMPRINT Pro Window

This chapter presents an overview of the components of the IMPRINT Pro 
window and how to move, resize, hide, display, close, and dock the window 
panes.

Chapter 5 IMPRINT Pro Menu Structure

This chapter describes the elements of the IMPRINT Pro menu structure 
and identifies the capabilities and features available under each element.

Appendix A Technical Description of Stressor Implementation
This appendix contains a discussion of the Evaluation of Human 
Performance under Diverse Conditions using Modeling Technology

Appendix B Human Performance Micromodels

This appendix contains a list of micromodels available in IMPRINT Pro.

Appendix C 

This appendix describes the impact of Training and Personnel 
Characteristics on taxons.

Appendix D

This appendix outlines the steps required to set up your machine to use 
Local Server and Remote Server functionality within IMPRINT Pro.
4
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Appendix E

Ths appendix lists the differences in functionality between IMPRINT 7 and 
IMPRINT Pro.

Glossary

The glossary contains a listing of the terms used in IMPRINT Pro.

Volume 2 – Developing Analyses in IMPRINT Pro

Chapter 1 Basic Procedures

This chapter describes how to create, open, and save analyses, export and 
import analyses and results, and search for text.

Chapter 2 Understanding the IMPRINT Pro Window

This chapter presents an overview of the components of the IMPRINT Pro 
window and how to move, resize, hide, display, close, and dock the window 
panes.

Chapter 3 Overview of Analyses 

This chapter describes the elements of an IMPRINT Pro Analyses, 
including Warfighter, Missions, Equipment, and User Stressor.

Chapter 4 Warfighters Data

This chapter describes how to enter the data needed to describe the 
warfighters that will operate, maintain, supply and support the system.

Chapter 5 Mission Analysis

This chapter describes the IMPRINT Pro Mission module and is divided 
into several parts, described below.

Subchapter 5.1 Mission Network Diagram

This subchapter describes how to create a mission model network diagram 
that describes the system mission.

Subchapter 5.2 Working With Missions 

This chapter describes the parameters for mission model components: 
5
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tasks, networks, comments, groups, variables, functions, events, and 
snapshots. It also describes how to establish performance parameters for 
the tasks, including time, accuracy, and workload.

Subchapter 5.3 Running the Mission

This chapter describes the settings that control model execution, including 
speed options. How to check a model for syntax and logic errors is also 
discussed.

Subchapter 5.4 Mission and Personnel Reports

This chapter describes methods used to analyze the model data and how 
to create charts displaying the values of variables during execution. How to 
export and open trace, queue, snapshot and task data files is also 
discussed.

Chapter 6 Equipment Analysis

This chapter describes the IMPRINT Pro Equipment analysis capability 
and is divided into several parts, described below.

Subchapter 6.1 Equipment Data

This subchapter describes how to enter the data needed to describe the 
system equipment, so that IMPRINT Pro can assess maintainability and 
availability of the system.

Subchapter 6.2 Scenarios

This chapter describes the parameters for operational scenarios: 
segments, maintainer manning, and sparing. 

Subchapter 6.3 Running the Equipment Scenario

This chapter describes the settings that control model execution, including 
speed options. 

Subchapter 6.4 Analyzing Equipment Results

This chapter describes methods used to analyze the results data and how 
to create charts displaying the values of variables during execution.

Chapter 7 Custom Performance Moderators

This chapter describes how users can create their own performance 
6
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moderator equations (stressor and training algorithms) that can be used to 
affect task time and/or accuracy.

Chapter 8 Force Data

This chapter describes how to predict the manpower needed to perform the 
routine work done by a force unit. Similar to the Define Equipment module 
in IMPRINT Pro, the Force Data module operates using a stochastic model 
which relies on various inputs you provide. 

Chapter 9 Plugins

This chapter describes how developers can create their own plugins to 
extend the runtime functionality of the IMPRINT Pro simulator. 

Glossary

The glossary contains a listing of the terms used in IMPRINT Pro.

Appendix A Technical Description of Stressor Implementation
This appendix contains a discussion of the evaluation of human 
performance under diverse conditions using modeling technology.

Appendix B Human Performance Micromodels

This appendix contains a list of micromodels available in IMPRINT Pro.

Volume 3—IMPRINT Pro Syntax Reference Manual

Chapter 1 Introduction

This chapter contains an overview of IMPRINT Pro, lists the contents of the 
guide, explains how to use the online help feature, and outlines the 
conventions used in documentation.

Chapter 2 Expressions

This chapter explains the constants, variables, functions, comments, 
operators, statements, and loops used to create IMPRINT Pro 
expressions.

Chapter 3 Built-in Macros

This chapter discusses built-in IMPRINT Pro functions, including Model, 
7
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Math, and Distribution.

Chapter 4 Probability Distributions

This chapter discusses the twenty probability distributions that are 
available in IMPRINT Pro.

Appendix

This appendix contains a list of syntax errors and fixes.

Glossary

The glossary contains a listing of the terms used in IMPRINT Pro.

Using Online Help

IMPRINT Pro contains extensive online Help to assist you as you work. To 
display help contents, select Help from the Help menu. 

Document Conventions

IMPRINT Pro documentation uses the following terms and typographical 
conventions:

File names, variables, and program code are shown in this 
typeface.

Labeled buttons, menu commands, and menu options are in 
bold. For example, Click OK to close the dialog box.

Information that the user needs to enter is in Arial Italic. For 
example, enter BO90001 in the text box.

Displaying Version Information

You can view version information for IMPRINT Pro. You may want to know 
8
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the version number when you are requesting technical support.

To display version information:

1. From the Help menu, select About.

The About IMPRINT Pro dialog box information displays. The version 
number of the software is indicated.

2. To close the dialog box, click the  in the upper right corner.
 

9
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Technical Support

You can e-mail any questions you have regarding IMPRINT Pro to the 
following address:

imprint-info@arl.army.mil
10



Chapter 2: Installing IMPRINT Pro
This chapter presents the instructions for installing IMPRINT Pro. In this 
chapter, you will learn the following:

Before you install IMPRINT Pro: what you need to know and 
what you should have on hand

System Requirements for installing and running IMPRINT Pro

How to install IMPRINT Pro

How to start IMPRINT Pro

Before you install IMPRINT Pro

What you should know
If IMPRINT 7 is already installed on your machine, there is no need to 
remove it. Your IMPRINT 7 data and program executables are preserved 
during the IMPRINT Pro installation. It is, however, recommended that you 
export analyses prior to performing this installation.

If an older version of IMPRINT Pro is already installed on your machine, 
you may choose to install this updated version update using this same 
installer. By performing this update, a new version of IMPRINT Pro (version 
3.0) installs on your machine while the older version also remains on your 
machine. This installation, however, remains separate from any previous 
installation of IMPRINT Pro on the system. This version, unlike previous 
versions of IMPRINT Pro, does not rely on the Microsoft SQL Server 
Database and therefore does not alter any existing files which are used by 
the pre-existing version of IMPRINT Pro. The first time the program is 
executed, however, all previously-existing analyses in the older version of 
IMPRINT Pro are scanned and copied into your new IMPRINT Pro 3.0 
analysis tree. All analyses are then saved as Imprint Pro Analyses (.ipa) 
files in your system’s Documents and Settings\...\Application Data\Alion 
Science and Technology - MA&D Operation\IMPRINT Pro\Data folder; all 
analyses exported from this new version are still exported as .xml-based 
IMPRINT Pro (.pro) files to the location of your choosing.

While data from your previous version is preserved during the update, it is 
recommended you export analyses prior to performing this update.
11
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An electronic copy of the IMPRINT Pro user guide automatically installs 
with this update and is available in the Help menu. PDF copies of the user 
guide may also be found in the IMPRINT Pro/Documentation directory.

What you should have
Before you install IMPRINT Pro, check that you have the following items:

IMPRINT Pro Installation CD

OR

IMPRINT Pro installation files from download

System Requirements

All systems on which this version of IMPRINT Pro will be installed should 
be done so only by either an administrator or other user account having 
administrative privileges. 

Hardware Requirements
The recommended hardware requirements to run IMPRINT Pro are the 
following:

1.5 GHz - Intel Pentium-class processor

512 megabytes (MB) of RAM (1 GB recommended)

1 gigabytes (GB) free hard disk space (additional space 
recommended as needed)

1280x1024 or higher-resolution display with 32-bit color quality

Microsoft mouse or compatible pointing device

CD-ROM

Software Requirements
Prior to running this installation of IMPRINT Pro, it is recommended that 
your system be updated with all available Microsoft Windows updates. The 
following are minimum operating system requirements:
12
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 Windows XP: Service Pack 2

Windows Vista

All systems on which IMPRINT Pro is to be installed are required to have 
the following components installed beforehand; these components are 
available through the IMPRINT Pro installation wizard or from files included 
with your IMPRINT Pro installation CD or download: 

1. Windows Installer 3.1

Windows Installer is part the Windows Operating System, but your 
system's current version may be out of date. The IMPRINT Pro setup 
will display an error and abort if this is the case. In most cases, you can 
determine if Windows Installer 3.1 is installed via Start  Settings  
Control Panel  Add/Remove Program. Windows Installer 3.1 is 
available through the following link: 

http://www.microsoft.com/downloads/details.aspx?familyid=889482FC-
5F56-4A38-B838- DE776FD4138C&displaylang=en

2. Microsoft .NET Framework version 3.5 Redistributable Package

If the installation detects that the Microsoft .NET Framework 3.5 is not 
already installed, you will be prompted to install it. This item may be 
installed from the files included with your IMPRINT Pro installation CD 
or download. Please keep in mind that it may take several minutes to 
install.

Installing IMPRINT Pro for the First Time

For user accounts expected to run IMPRINT Pro with Administrative, 
Standard or Restricted access, the following steps must be performed by 
the system administrator installing this software.

To install IMPRINT Pro:

1. Log into the system with Administrative privileges.
13
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2. Insert the IMPRINT Pro CD into your CD-ROM drive. Open Windows 
explorer and navigate to the files on the CD.

OR

Download and unzip the IMPRINT Pro installation.

The files included in your installation are based upon the version of 
IMPRINT Pro currently distributed by ARL.

Note:
For more information on obtaining a copy of IMPRINT Pro contact imprint-
info@arl.army.mil.

3. Navigate to the file called Setup.exe. Double-click this file to launch 
the IMPRINT Pro installation wizard which will guide you through the 
installation.

4. Follow the instructions that display on the screen to complete the 
installation process. You may install IMPRINT Pro using all default 
settings in this wizard.

By default, IMPRINT Pro installs to the following directory:
C:\Program Files\IMPRINT Pro 3.0

Note:
The folder indicated above is the default installation folder for IMRPINT Pro. 
You may choose to install this item to a location other than the default.

5. Once the installation is complete, exit the installation wizard and reboot.

6. Launch the IMPRINT Pro application. 

Upon starting IMPRINT Pro 3.0, you might be prompted to install the 
Microsoft .NET 3.5 Service Pack 1 framework.  This framework is a 
free package available through Microsoft.com and is required for 
running IMPRINT Pro 3.0.  If you are prompted, proceed to download 
and install this package.  Once finished, reboot your machine, and then 
re-launch the IMPRINT Pro application.

7. By starting IMPRINT Pro the following folder(s) are created in 
Application Data directory belonging to the user account under which 
IMPRINT Pro is launched:

Windows XP:
14
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 C:\Documents and Settings\[user]\Application Data\Alion Science and 
Technology - MA&D Operation\IMPRINT Pro\Data

Windows Vista:
C:\\Users\[username]\AppData\Roaming\Alion Science and 
Technology - MA&D Operation\IMPRINT Pro\Data

These folders store all IMPRINT Pro analyses in-progress (.ipa files) 
post import/creation and prior to export.  They also contain the directory 
file (.ipd file) which keeps track of the analyses and folders in your 
application.  In the event IMPRINT Pro 3.0 is later uninstalled through 
the IMPRINT Pro installation wizard or through the Control Panel, the 
Data directory(ies) above and all files they contain remain unless 
manually deleted.  By re-installing IMPRINT Pro 3.0, you may resume 
access to and use of these analysis files as before.

For individual Vista machines having multiple user accounts: each 
account having its own unique login on the same local machine will 
have its own unique set of analysis files (.ipa and .ipd files) for IMPRINT 
Pro 3.0. locally on that machine.

You are now ready to use IMPRINT Pro.

Updating from version 0.0.8.43 and later

For any system already having a version of IMPRINT Pro (8.43a or later) 
installed, you may run the “Update” option in this installation to install this 
latest version of IMPRINT Pro. 

To first determine your currently installed version, 

1. Start up the IMPRINT Pro application.

2. Click the Help menu option located at the top of the IMPRINT Pro 
window.

3. Select the About option. Look for the version number in the window 
which appears.
15
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Updating from versions prior to 0.0.8.43

In the rare case that an older version of IMPRINT Pro (older than 8.43a) 
is installed on your system, this older version must first be removed 
before installing this version of IMPRINT Pro. To do this, go to Start --> 
Settings --> Control Panel --> Add/Remove Programs and choose the 
option to remove IMPRINT Pro. (Do not, however, remove the MySQL 
application or any of its folders or files as they are also required to run 
IMPRINT 7 and IMPRINT Standard.)

Starting IMPRINT Pro

To start IMPRINT Pro:

1. Click the Start button, and then point to Programs.

2. Select IMPRINT Pro, and then select the IMPRINT Pro icon and 
program name. You can alternatively double-click the IMPRINT Pro 
icon on the desktop.

IMPRINT Pro opens.

Note:
After installing IMPRINT Pro and its supporting applications, you may start to 
add and import analyses to work on as desired. Before beginning any analysis 
work in IMPRINT Pro, however, we recommend that you first check your 
settings for your local server where your analyses will be saved. You may also 
optionally set your system up to work with a remote server in order to access 
files from a networked computer running the same version of IMPRINT Pro. 
For more information on setting up the Local Server and Remote Server 
Environments see “Local Server Environment vs. Remote Server 
Environment” on page 179.

Monitor Resolution Issues
For IMPRINT Pro users who have monitors which default to 120 dpi, you 
may notice an issue where many labels and text fields appear cut off. For 
example, on the task workload demand interface, the interfaces of the 
resource-interface pairs might appear completely cut off.   

You may choose from one of the following three options: 
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Leave your monitor’s resolution at 120 dpi; this will result in 
labels appearing cut off. 

Change your monitor’s resolution to 96 dpi and keep the 
resolution high; this will result in small text.

Change your monitor’s resolution to 96 dpi and change the 
resolution to be lower; this will result in larger text and smaller 
working windows, in terms of usability.
17
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Chapter 3: Understanding IMPRINT Pro 
Analyses

This chapter presents an overview of IMPRINT Pro analyses. Sections 
discuss the components of IMPRINT Pro, including how to define 
Warfighters, Missions, Equipment, and User Stressor elements. The 
chapter concludes with a general discussion of the steps involved in 
creating, debugging, and running an IMPRINT Pro analysis.

Warfighters Module

The Warfighters module helps you estimate the type of people that will be 
available to operate and maintain the system you intend to model for the 
manpower, personnel and training (MPT) analysis.

This module lets you select Military Operational Specialties that are likely 
to be available, probably from a predecessor system, to operate and 
maintain the new system. It then permits you to see a profile of these 
specialties for the current year with estimates on their personnel 
characteristics.

Questions That Can be Answered in the 
Warfighters Module

What types of people are currently in a specialty?

What types of soldiers (in terms of personnel characteristics 
such as gender, education, etc.) may be available to operate, 
maintain, and support a system?

What number of the soldiers in this specialty are Test Score 
Category IV?

How many people of this specialty are high school graduates?
19
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Elements of the Warfighters Module
The only element of the Warfighters module is the Warfighter. A Warfighter 
is any person or automated device that operates, maintains, supplies or 
supports military equipment; Warfighters are categorized as such 
(Operators, Maintainers and Supply and Support Personnel) as they are 
added to an analysis under the Warfighters node in the tree. Each 
Warfighter is described, at minimum, by a three-character specialty 
designation, for example 11B or 67U. Once the desired Warfighters have 
been added to your analysis, you may determine the Warfighter profile by 
running the Personnel Attributes report available through the Reports 
menu.

Mission Module

IMPRINT Pro allows you to analyze a new weapon system by helping you 
build models of each mission that the weapon system will be capable of 
accomplishing. Since it is typically easier to describe the mission by 
breaking it into smaller “sub” functions than trying to describe the mission 
as a whole, you build these models by breaking down the mission into a 
network of functions. Each of the functions is then further broken down into 
a network consisting of other functions and tasks.

Then, by executing the mission model simulation, you can study the range 
of results that occur in the mission. A description of the variability of each 
element can be obtained for further analysis.

IMPRINT Pro performs the simulation analysis based on how long you tell 
it to perform each task in the mission. In addition, with each task, you 
estimate accuracy levels and assign workload values that reflect the 
amount of effort the warfighter will have to expend to perform the task. 
During the simulation, IMPRINT Pro predicts task performance and 
calculates how much workload each warfighter was experiencing 
throughout the mission. In this way, you determine whether the warfighters 
were overloaded, and if so, how changes can be made to reduce the 
workload to an acceptable level.

At the completion of the simulation IMPRINT Pro can compare the 
minimum acceptable mission performance time and accuracy to the 
predicted performance. This will determine whether the mission met its 
performance requirements.
20
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Questions That Can be Answered in the 
Mission Module

How much effort must a Warfighter expend to perform a task?

What is the amount of workload a Warfighter will experience 
throughout the mission?

Are any Warfighters overloaded?

Was the minimum performance time and accuracy of the mission 
completed as predicted?

Were the performance requirements of the mission met?

How will our new weapon system perform?

Elements of the Mission Module
The central element of Missions module is the task network. The task 
network encompasses the following elements:

Warfighters who represent the operators performing the tasks in 
your model.

Tasks which represent the steps in the process or “mission” you 
are attempting to model.

Task Attributes that specify the parameters associated with each 
task, including warfighter assignment, time, accuracy, and 
workload.

Functions which contain sub-networks of tasks.

Paths which connect the functions and tasks in your model so as 
to direct the flow of entities running through your model when it is 
executed.

Goals which represent events external to the network modeled 
but which can have an impact on your mission when they fire.

RI Pairs, or resources and interfaces used by each operator in 
the mission.

Macros that return values or perform procedures when they are 
called in tasks.
21
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Variables you define to represent changeable system states or 
characteristics, with values that change as tasks begin and end 
or scenario events occur.

Snapshots that collect the values of particular variables when 
triggered by conditions that you specify.

External Events that you schedule to occur at specific clock 
times to change the values of variables.

Charts that display the values of selected variables at run-time.

Cultural Templates that allows for the creation of a template to 
define the cultural and country differences that might cause 
people to react differently in a situation.

Plugins that communicate with other applications.

These elements and their interrelationships are shown in the following 
diagram. The diagram does not show a logical flow of model execution, but 
illustrates the general relationships between the aspects of a model.
22
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Warfighters
Warfighters define a crew for your model. In an operational mission, 
Warfighters comprise Operators in your analysis who perform the tasks in 
your operations model. For each Warfighter you add, you can choose a 
specialty appropriate to the task the Warfighter will be assigned.

For each operator in the mission, you may additionally set a “default” flag to 
indicate that Warfighter’s role in the system as well as a workload threshold 
and workload management strategy to help model realistic operator 
actions under conditions of work overload. Lastly, you may designate the 
operator as an automated device if the task is to be performed by a 
machine.

Tasks
A task represents the most basic building block in the mission you are 
modeling.
23
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Task Attributes
Every task you add to your network can be defined by the following seven 
attributes:

Time and Accuracy - the length of time this task usually takes 
and the likelihood this task will fail.

Effects - the circumstances which must occur before, during and 
after the firing of this task. 

Failure - the consequences as a result of this task failing.

Crew - the operators who will be performing the task.

Taxons - the categorization used to describe the workload 
composition of your task in a way that can be understood by 
performance moderators.

Paths - the decision logic describing the conditions under which 
each of the individual paths leaving a task are taken.

Workload Demand - value(s) indicating the relative demand on 
an operator performing a task.

The execution time for each task varies within the parameters you supply 
(usually distribution type, mean time, and standard deviation). Additionally, 
as each task executes it can alter the state of the system with expressions 
called “effects.” Effects are executed either at the beginning or at the end of 
a task. For example, the beginning effect of a machine task might decrease 
the number of available machines by one while the ending effect would 
increase the number by one.

Each task can also check the state of the system before it executes and 
delay execution until a certain condition, called a release condition, is met. 
For example, assume you define a variable named Workers that tracks 
the number of available operators. If you have a task that requires an 
operator to perform it, the condition Workers > 0 must be true for the 
task to execute.

Functions
Functions are the primary organizing items of the mission network and 
represent groups (or networks) of tasks. Functions do not have 
performance estimates of their own. Rather, they only encapsulate tasks.
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Paths
After adding the functions and tasks to your network to describe the 
different steps in your model, you must add the paths between them to 
direct the flow of your model. When you execute a model, an entity starts at 
the task you designate as the starting point. The entity then travels along 
the paths(s), executing each task it encounters. When more than one path 
leaves a task, the decision on which path to take will be determined by the 
value set in the task’s decision node. Decision nodes are automatically 
added to a task by IMPRINT Pro and display in the network diagram as a 
diamond-shape on the end of a task node. Each contains a letter inside of 
it (S, T, P, or M) indicating the branching logic the entity should follow. 

IMPRINT Pro uses four different branching logic decision types: Single, 
Tactical, Probabilistic, or Multiple. Tasks with Single nodes indicate the 
entity flowing through has only a single path it can follow at that point in the 
network. Tasks with Multiple nodes cause an entity to split up into multiple 
entities so that all paths out of the task are followed; these entities must 
later rejoin. The paths that the entity follows can vary, however, if you 
include probabilistic or tactical routing decisions. In a probabilistic decision, 
you specify the probability of each following task, and IMPRINT Pro selects 
the path to follow randomly within these probabilities. In a tactical decision, 
you specify the system conditions under which each following path can be 
selected. You can define these conditions and probabilities using 
expressions, operators, and variables that represent the state of the 
system.

Goals
IMPRINT Pro allows you to model human performance in a goal-driven 
context. This capability allows you to specify individual goals, the tasks 
associated with these goals, the triggering conditions, and the interaction of 
goals with each other and with workload.

RI Pairs
IMPRINT Pro provides capabilities for you to predict and assess the 
workload involved in performing tasks. This capability is consistent with 
well-known and documented theories of workload prediction, including the 
Wickens Multiple Resource Theory (MRT). 1 

1. Wickens, C.D., Yeh, Y-Y, 1986, A Multiple Resource Model of Workload Prediction
and Assessment. In Proceedings of the IEEE Conference on Systems, Man, and Cy-
bernetics (Atlanta, Georgia).
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Seven default human resources are provided within IMPRINT Pro. They 
include Auditory, Cognitive, Fine Motor, Gross Motor, Speech, Tactile and 
Visual. You can add more resources to the list if you desire. Additionally, 
you can identify specific interface elements (that is, controls and displays) 
that the warfighters will interact with. If your system design is not yet 
mature enough for that level of detail, then you can accept the default 
interface named “Crewstation.”

Macros
IMPRINT Pro uses two types of macros: built-in macros, which are 
available to all missions, and custom macros, which you define for use 
within a particular mission. Both macro types work in a similar manner. You 
can include the macro’s name or call the macro in any expression. When 
IMPRINT Pro encounters the macro, it executes the macro and returns a 
value that can be used in the expression.

Built-in macros include the following categories:

Modeling macros, which perform actions such as starting or 
stopping tasks, and pausing or stopping model executions.

Mathematical macros, which perform mathematical operations, 
such as calculating the minimum and maximum and 
trigonometric functions.

Distribution macros, which generate random numbers for task 
execution according to a certain distribution.

Custom macros are particularly useful for calculations or procedures that 
you want to execute at more than one place in a model. For example, you 
might create a macro to calculate task time based on new research you 
have available. You would embed the new calculation in a custom macro, 
and then “call” that macro in the task mean time expression.

When macros are called in IMPRINT Pro, they are followed by 
parentheses, for example CalculateTime( ). To return a value from a 
macro, the macro itself must be defined with a return value (for example, 
an “integer”).

Variables
Variables are an important element in any model because they keep track 
of the state of the system. Five system variables are automatically created 
for each IMPRINT Pro model. Additionally, you can define variables 
specific to each model.
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The variables you define can keep track of whatever is appropriate for the 
model—how many items are processed, what the current temperature is, 
or whether a machine is on or off. Variables give different tasks, queues, 
and scenario events a way to interact with each other because they can 
evaluate and modify variable values.

Default system variables include the following:

Clock records elapsed time (in simulation time units) since the 
beginning of model execution.

Distributions allow access to all the model distributions. 
Distributions are used to determine task execution times.

Entity includes all the entity variables.

Model is used to control model actions, such as halt and pause.

Task includes all data attached to each task in the network 
model.

Snapshots
Snapshots provide a way to collect values of variables at specified times 
during model execution. You can specify snapshots to be gathered at 
specific clock times (one-time or repeating), when a task begins or ends, 
when an entity enters or leaves a queue, or when a model run ends.

External Events
External events provide a way for you to cause events to occur at specific 
times during mission model execution. These can be one-time events, or 
events that repeat at regular intervals. External events are often used to 
change variable values, thereby changing the state of the model. For 
example, you might have a variable called temperature that would 
increase at 15-minute intervals during the day and decrease during the 
night. You could then make the times required for tasks such as warming 
up an engine be contingent upon the current temperature.

Charts
The Chart option allows you to display a plot of one mission variable 
against another. Since the value of your model’s variables is determined at 
run-time, the points representing these variables’ values are plotted on the 
chart at run time as the animation progresses.
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Cultural Templates
In IMPRINT Pro, cultural modeling is defined as the application of cultural 
or country based influences on human behavior or performance within a 
human performance model. Given a situation with the same physical 
conditions and the same resources, people from different cultures or 
countries may react to the situation and apply their resources differently. A 
cultural difference exists when the “average” reaction of a population from 
one culture differs from that of another.

IMPRINT Pro allows users to create and save profiles, or templates, which 
define the relevant cultural parameters for each culture modeled and the 
values derived from cultural data that are assigned to those parameters. 
One or more templates can be defined by the user. At execution time, the 
user selects the template that is to be used.

The user selects the cultural parameters that are affected by a selected 
culture and assigns the appropriate values for those parameters based on 
the cultural data. IMPRINT Pro also allows the user to specify default 
values for each cultural parameter. The default value is used when cultural 
data for a parameter is not available.

Equipment Module

The Equipment module helps you estimate the maintenance manhours 
required to attain acceptable system availability. This module lets you enter 
parameters that control such items as the maintenance manpower pools, 
the spare availability, and the combat damage potential. These 
parameters, coupled with a mission schedule and the data describing the 
maintenance actions that your system may need are combined in a 
stochastic maintenance simulation.

Questions That Can be Answered in the 
Equipment Module

How many people of each specialty do I need in order to meet 
the system availability requirement?

Which pieces of equipment (that is, subsystems) are the high 
drivers for maintenance?

How should each organizational level be staffed?
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How sensitive is my maintenance manpower requirement to the 
failure rates of individual components?

Elements of the Equipment Module
The elements of the Equipment module include Subsystem and Scenarios.

Subsystem. You will break your Equipment analysis down into 
Subsystems. A major subsystem is typically something like an 
engine, landing gear, or main gun. Next, you will decompose 
your subsystem into components. Components are the individual 
pieces of equipment that have repair tasks attached. You can 
enter or edit maintenance data for all repair tasks associated 
with the components.

Scenarios. A Scenario is a configuration defining the set of 
conditions under which the components will be used. You can 
develop many scenario data sets for each system. For example, 
you might want to create one scenario for a thirty day run and 
another scenario that contains input parameters for a ten day 
run. When you have selected a scenario, you can add mission 
segment data for that scenario. You can add, duplicate, and 
delete scenarios.

This interface contains the list of scenarios available for your 
maintenance analysis. In order to view more information about a 
scenario, highlight it and double-click. This will let you edit and 
review the scenario parameters.

Force Module

The objective of the Force Analysis module is to help predict the manpower 
needed to perform the routine and unplanned work done by a force unit. 
Similar to the Define Equipment module in IMPRINT Pro, the Force 
Analysis module operates using a stochastic model which relies on various 
inputs you provide. 

Questions answered by the Force Module
What is the elapsed time for my planned and unplanned 
activities?
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What is the cumulative amount of time an activity was performed 
over the course of the entire model run?

What was the status of an unplanned activity during the model 
run?

How many unplanned activities failed because the minimum 
number of Leaders, Sub-Leaders and Members required for this 
unplanned activity could not be met?

Elements of the Force Module
Force Analysis Data consists of the following items:

Force Units. A Force Unit is a group of individuals who perform 
activities according to a schedule.

Schedule. A Schedule is a pre-defined sequence of activities, 
planned and unplanned, over a specific amount of time.

Planned Activity. A planned activity is a routine task. Examples 
may include guard duty, hygiene, eating and sleeping.

Unplanned Activity. An unplanned activity is an activity which 
interrupts a normal schedule. Examples may include fire and 
emergency.

Activities Trump Matrix. The Activity Trump Matrix is used to 
set task priority within a schedule for when any two activities 
overlap.

Jobs. Jobs are general tasks, or occupations, which makes up a 
force unit. A job is defined by a name, specialty, rank and role. 
Examples may include Tank Driver, Navigator and Analyst.

Custom Moderators

IMPRINT Pro user can create custom moderator equations, or more 
specifically custom stressors and custom training moderators, that can be 
used to affect task time or accuracy. Identify the moderator (for example, 
“vibration”), then enter algorithms that link levels of the moderator to 
performance impacts by taxon. This is a way to embed your own 
experimental findings into an IMPRINT Pro model.
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Plugins

IMPRINT Pro contains a powerful plugin interface that allows developers to 
extend the runtime functionality of the simulator. This API provides 
extensibility and flexibility that far exceed the External Model Call 
functionality of IMPRINT 7, yet is much easier to create, debug and use.

Using plugins in a model is simply a matter of calling a method defined on a 
plugin object, passing to it those values desired, and using the result (if 
any). This can be done from any code window in the program, for example 
the Effects, Release Conditions, or Expressions windows.

Any public method defined in the plugin class will be available to all 
analyses in IMPRINT Pro. Any use of a plugin method will be checked for 
type compatibility by the Syntax Checker; programmers are immediately 
alerted to problems with the plugin code through text displayed in the 
Output window.

How to Create an Analysis

This section presents an overview of the analysis process and provides 
some tips and pertinent questions to help make sure you are on the right 
track at each step. It also emphasizes the early steps to perform before you 
begin building an analysis in IMPRINT Pro.

While the steps in this list are numbered, keep in mind that the analysis 
process is iterative. You may go back and forth between various steps in 
the process as new ideas occur to you, and you may go through several 
revisions of the analysis before you reach a final version. There is no one 
correct sequence that you need to follow.

In general, however, you develop an analysis through the following 
process:

Determine the questions you want to answer.

Before you start building an analysis, be sure to think about 
what it is you are trying to determine. If you try to model the 
entire weapon system when all you really need to do is 
determine how many maintainers with a specific specialty you 
need to repair the diesel engine when it breaks, you will expend 
a lot of extra effort. Build the analysis to answer your questions, 
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rather than thinking of the questions after you build it. We 
recommend that you think of your analysis as though it were an 
experiment, by identifying dependent and independent 
variables. This will help make sure that your analysis is 
structured so that it will answer your question.

Determine the IMPRINT Pro modules that are best suited to 
your analysis needs. The “Questions that can be Answered” 
sections can help you identify the modules in IMPRINT Pro that 
will be most helpful to you.

Analyze the process you want to model.

 Once you know which IMPRINT Pro modules you will be using, 
you will know what data are necessary to support the analysis. If 
you choose the Mission module, you will need to be able to 
draw a diagram of the operational mission that you want to 
represent, and you will need to understand the flow of the 
mission thoroughly. Determine what tasks are involved in the 
process, the sequence in which they are performed, what 
resources they use, whether there are any restrictions on when 
they can be performed, and how they affect the overall system 
being analyzed. If you are using the Equipment module, you will 
need a list of the relevant subsystems and components in your 
system.

At this stage, we recommend that you proceed hierarchically. 
That is, begin by identifying high level elements of your system, 
and only decompose them if they impact the analysis you are 
performing.

Enter data.

As you determine what tasks and components are involved in 
your analysis, you also need to specify the data elements (as 
described in the relevant sections above). Examples of these 
elements are how long each task requires to execute and how 
the times for each task are distributed. IMPRINT Pro has 
capabilities to help you with these estimates, both through the 
libraries of Army data included in the tool, and through the 
calculators embedded within the tool (for example, micro-
models, unit converters).

Define the variables and system changes.
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These elements of your analysis will probably align with the 
dependent and independent variables you identified in the first 
step. These elements help ensure that the analysis is properly 
parameterized so that you can exercise it with a minimum of 
changes to the data set itself. At this step in the process, you 
should also consider whether there are any other system 
characteristics you should represent with variables. Have you 
represented all environmental changes in the system that might 
affect task performance? Have you included all important counts 
and measurements that change as the simulation progresses? 
Have you included all the quantities that you want to use as 
input to or output from the system?

Check for errors.

IMPRINT Pro includes a built-in syntax checker and error 
checking routines that automatically searches the analysis to 
ensure that you have entered the data needed to conduct your 
analysis. Also, if you are using the Mission module, 
IMPRINT Pro searches your mission for errors in syntax. Any 
detected errors are displayed so that you can correct the 
problem.

Run and debug the analysis.

After you start the analysis execution, IMPRINT Pro has several 
different built-in tools that you can use to help you locate any 
logic errors in the analysis. If you are using the Mission module, 
you will see a symbolic animation of your mission network as 
the simulation progresses so that you can check to be sure the 
flow is logical.

Analyze the data.

You can examine all the results of an IMPRINT Pro analysis by 
accessing the Reports menu. Tables, charts and graphs are 
automatically generated to help you visualize the results. As you 
analyze the data, you will start to answer the questions you 
originally asked—and you may discover more questions that 
lead you to further development of the analysis.
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IMPRINT Pro Window

IMPRINT Pro uses a modified form of the MDI (Multiple Document 
Interface) made available by Microsoft .NET Framework. MDI provides a 
parent container window that contains several other different window 
panes. This configuration allows you to reposition windows into logical 
working groups and to temporarily hide windows that you are not using. 
The IMPRINT Pro window is highly configurable, and changes to these 
configurations are preserved until the next time they are modified.

In this chapter, we describe methods you can use to navigate through the 
IMPRINT Pro interface, and customize the layout so that it meets your 
model needs and user preferences.

IMPRINT Pro Window Overview

The default configuration for the IMPRINT Pro window consists of a 
container window with a title bar, menu bar, tool bar, and status bar. Within 
this container, the following elements exist as separate window panes: 
Analysis Tree, Windows, Network Diagram, Properties Window, Palette, 
Event Queue, Output, and Variable Watches.

Note:
Many of the windows are blank until you open an analysis. To open an 
analysis, right-click in the Analysis Tree, select Add Analysis or Add 
Analysis from Library, and select the desired analysis from the dialog box 
that displays.

You can move, resize, hide, and dock all of the windows. You may want to 
use different configurations during different stages of model development. 

The following illustration shows the components of the IMPRINT Pro 
window. Each of these components is described in greater detail in the 
remaining sections of this chapter.
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IMPRINT Pro Window Components

This section describes the window components in the main IMPRINT Pro 
window. For details on resizing, moving, hiding, and docking the windows, 
see “Manipulating Windows” on page 50.

Title Bar
The title bar displays at the very top of the IMPRINT Pro window and 
contains the name and version of the currently open analysis.

Menu Bar
The menu bar displays below the title bar at the top of the IMPRINT Pro 
window and contains the File, Edit, View, Reports, Tools, Utilities, and 
Help menus. After opening your mission, the expanded menu will display 
the additional options of Moderators and Execution.
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File. The File menu includes the following basic commands: 
New Local Folder, New Analysis, Import Analysis, Library 
Analysis, Import Maintenance Data, Save Analysis, Save As, 
Close Analysis, Close All Except Current Analysis, Print Diagram 
and Exit.

Edit. The Edit menu includes basic edit commands such as 
Undo, Redo, Cut, Copy, Paste, Copy Diagram as Image, Clear 
Output and Preferences.

View. The View menu contains commands to zoom the display, 
display different windows, and reset the screen layout.

Moderators. The Moderators menu (available only when a 
mission is selected) includes commands for mapping workload 
or maintenance tasks to taxons, setting Performance Moderators 
and reviewing the affects of those moderators on task times and 
accuracies.

Execution. The Execution menu includes commands for 
controlling execution, such as Begin, Pause, Step, Halt and 
Abort Simulation. It also includes Check for Errors, an option to 
run a syntax check on your model, and Settings, an option to 
adjust model execution settings (execution speed, number of 
runs, simulation speed and more).

Reports. The Reports menu includes options for generating 
detailed reports which display the results of your model run. 
Options include Operations Results, Maintenance Results, Force 
Results, Personnel Attributes and Cross Analysis. All reports 
display in a Microsoft Excel format.

Tools. The Tools menu includes commands to display additional 
tools which may be helpful when configuring your model’s tasks. 
Tool options include Accuracy Calculator, Micromodels, Syntax 
Helper, and Unit Conversions windows.

Utilities. The Utilities menu includes commands for enabling 
Display Trace, Network Animation and Update Comment 
Variables. Commands for controlling the network nodes in the 
diagram (Alignment, Snap to Grid) also appear in this menu. You 
may also view the entire model in a table format using the Export 
Network to Excel option.

Help. The Help menu contains the About command to display 
version information and the Help command to open online help.
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Tool Bar
The IMPRINT Pro tool bar displays below the menu bar and provides quick 
access to commonly used commands. Each command displays as a button 
on the tool bar which may be clicked to access the command. Options 
include: Save Analysis, Copy, Cut, Paste, Undo, Redo, Check for Errors, 
Begin Simulation, Pause Simulation, Step Simulation, Halt Simulation, 
Simulation Speed, Custom Layout 1, Custom Layout 2 and Custom Layout 
3.

The tool bar also includes options for the Accuracy Calculator, 
Micromodels, Syntax Helper, and Unit Conversions tools. 

As you move the pointer over each button, a tooltip displays the 
corresponding command name and the associated shortcut key, if 
available.

Windows
The IMPRINT Pro windows are all items in the IMPRINT Pro interface other 
than the Title Bar, Menu Bar and Tool Bar. These windows are used for 
selecting application options, entering data or displaying data.

Windows Pane

The Windows pane contains a list of all 
windows available for display in 
IMPRINT Pro. Similar to the Tool Bar, the 
Windows Pane is intended to provide quick 
access to commonly viewed windows through 
icons which may be clicked to access the 
desired window(s). Available windows include 
the Analysis Tree, Animator, Event Queue, 
Network Diagram, Output, Palette, 
Properties, Search, and Variable Watches.

In the default configuration, the Windows Pane displays on the left side of 
the IMPRINT Pro container window. 

Windows are described in the following sections.
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Analysis Tree Window

The Analysis Tree window displays a 
hierarchical list of the analyses, 
automatically sorted by name. Listed 
under each individual analysis are the 
Warfighters, Missions, Equipment, 
Custom Performance Moderators and 
Forces nodes.

To expand a node in the tree view, click 
the plus sign “+” adjacent to the item. To 
collapse a node, click the minus “-” sign 
adjacent to the item. 

To select an item in the tree, left-click 
the item with the mouse.  To select 
multiple items in a row, click the first and last items in the desired subset 
while holding down the shift key.  Multiple items which are not grouped 
together may be selected simultaneously by clicking each item while 
holding down the control key.

Palette Window

The Palette displays the tools used to 
construct the network diagram. These 
tools consist of network node objects 
made to represent the six optional items 
you may add to your network diagram: 
tasks, functions, scheduled functions, 
goals, comments and workload 
monitors. To add one of these items to 
the network diagram, click the item in 
the Palette window and drag it onto the 
network diagram window. You can then 
enter its defining parameters in the 
Properties window.
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Network Diagram Window

The Network Diagram displays the graphical depiction of the task network 
developed under the Mission module. Use this window in conjunction with 
the Palette to construct the task network diagram and view the mission 
model execution.

Animator

The Animator window displays a two dimensional graphical depiction of 
your model as it executes. The data displayed in the Animator window 
depends on the model type you choose to run:

Operations model. The Animator window displays workload 
data for crew members in your operational mission.
40



Chapter 4: Understanding the IMPRINT Pro Window
Maintenance model. The Animator window displays queue 
data, combat data, reliability and availability data and 
maintenance summary data for your maintenance scenario.
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To add animation to your model run:

1. Go to the Windows option under the View menu, and select the 
Animator option to add the display window to your current layout. 

2. In the Settings option under the Execution menu, check the 
Animation On check box on the Execution Settings dialog. 

The animation displays the next time you run your model scenario.
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Properties Window

The Properties window displays the 
properties of the model item 
selected in the network diagram, 
such as a function, task, or goal. It 
also displays the properties of 
items that you select in the tree 
view such as variables, macros, 
scenario events, and snapshots. 
The properties that display in the 
Properties window also display in 
the dialog box for the associated 
item.

The Properties window functions 
like any folder list. To expand an 
item, click the adjacent plus “+” 
sign. To collapse an item, click the 
adjacent minus “-” sign.

Some of the fields in the Properties window have an associated drop-down 
list box. To display the list box, click in the text box, and a drop-down arrow 
displays. Click the arrow, and a selection list appears. A detailed 
description of any selected item automatically displays at the bottom of the 
Properties window.

Output Window

The Output window displays the trace of the execution which consists of all 
actions that just finished occurring in the model run. The clock times for 
beginning effects, ending effects, and scenario events are listed. 
Application errors, plugin loading errors, and the start and end of a 
simulation are also included. Any syntax errors are indicated and you can 
use them for debugging purposes. You can save the information in the 
Output window to a file or to the Windows clipboard and clear the 
information in the window before running a new simulation.
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Variable Watches Window

The Variable Watches window displays the values of variables during 
model execution. You select the variables that you want to display by 
creating a watch for the variable. The variable name, value, and type 
display. For variables designated as arrays, indices display in the Index(es) 
field.

To add a Variable Watch:

1. Click the Variable Watches tab in the lower right-hand corner of the 
IMPRINT Pro window.

2. Click the Add Watch button.

A new variable watch line appears in the Variable Watches window.

3. Under the Variable column, click the cell containing the variable name - 
a drop-down arrow appears. Click the drop-down arrow to access a list 
of variables in your mission. Select the variable whose values you wish 
to view.

4. Run the model.

The variable type and values display in the cells to the right and 
continue to update as the model runs. 
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Event Queue Window

The Event Queue window displays the list of events as they occur during 
model execution. These include the execution of tasks and scheduled 
events. You create the scheduled events for the simulation. Scheduled 
events can be one-time events or they can repeat at regular intervals. The 
group, ID, tag, and time, and type of event displays.

Beginning effects are highlighted in navy, ending effects are in green, 
suspended beginning effects are in blue, and suspended ending effects 
are in lime. Evaluate queue is in fuchsia, leaving queue is in purple, and 
waiting without queue is in red. And finally, scenario events are in yellow, 
and snapshots are in maroon.

Search and Replace

The Search and Replace window allows you to locate a string of text in the 
model. You may then choose to replace select instances of that string with 
a new string you specify. You can search open analyses, closed analyses 
or any combination thereof. Within the analyses you choose to select, you 
can search either the currently-open model (e.g., operations model) or all 
models (e.g., operations model, equipment model and force model) within 
those analyses.

Depending on the models types you choose to search, you will then be 
presented with a list of components to refine your search parameters. The 
following fields may be searched for the model types listed:

Operations model: Warfighters, Stressors, Goals, Functions, 
Tasks, RI Pairs, resources, Interfaces, Macros, Variables, 
Snapshots, External Events and Cultural Templates.
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Maintenance model: Warfighters, Stressors, Subsystems, 
Components, Repair Tasks, Scenarios and Segments.

Force model:   Warfighters, Stressors, Force Units, Schedules, 
Jobs, Planned Activities and Unplanned Activities.

To search for text:

1. Open the Search and Replace window.

2. In the What to Search field, check the boxes corresponding to the 
types of analyses you wish to include in your search. You may choose 
Closed Analyses, Open analyses and/or Current Analysis. If you 
choose the Current Analysis option, you can choose to search only the 
currently-opened model by checking the Current Model Only box 
below. Otherwise, you may leave the box unchecked to search all 
models in the current analysis.

The Look In field below displays the options available based on the 
items you checked.

3. In the Look In field, check the boxes corresponding to the components 
within the selected analyses you wish to include in your search.

4. If you wish to locate only those instances whose case matches what 
you have typed in the Find field, check the Match Case box at the 
bottom of the window.

5. Click the Find button at the bottom of the window.

All instances of the text string appear on the right side of the window in 
the following two fields:

Replaceable. All instances found in this field may be replaced 
with new text you specify in the Replace With field.

Not Replaceable. All instances found in this field are non-
editable. 

Note:
If you are searching for text with the Close Analyses box checked, several 
instances of your text could appear in the Not Replaceable field. In some 
cases you may make these instances replaceable by first opening (expanding) 
the analysis in the tree corresponding to this instance and then clicking the 
Find button again; all replaceable instances of this text string within the 
selected analysis will now appear in the Replaceable field.
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To replace text:

1. In the Replaceable items field, check the boxe(s) of the instance(s) 
where you wish to replace text. For each listing a Found in Object line 
and a line number message will appear. When you check one box, both 
with automatically be selected.

If you wish to choose all found instances, click the Check All button at 
the bottom of the window. To de-select any or all checked items, click 
the Check None button at the bottom of the window.

2. In the Replace With field on the left side of the window enter a 
replacement text string.

3. In the lower right-hand corner of the screen click the Replace Checked 
button to replace text in all selected instances with your new text string.

All instances selected are replaced with your new text.
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Status Bar
The status bar displays at the bottom of the IMPRINT Pro window. Any 
execution-related messages, such as the clock time and the run number, 
display on the right side of the status bar.

Window Configurations

IMPRINT Pro provides three customizable window configurations or views, 
Custom Layout 1, Custom Layout 2, and Custom Layout 3. These views 
default to the layouts described in the following list.
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Custom Layout 1 displays the default configuration of the 
Windows, Analysis Tree, Network Diagram, Properties, and 
Output windows. Tabs at the bottom of the windows display 
including Palette, Variable Watches, Event Queue, and Search. 

Custom Layout 2 displays the default configuration of the 
Network Diagram, Analysis Tree, and the Output window. Tabs 
at the bottom of the windows display including Palette, 
Properties, Variable Watches, Event Queue, and Search. The 
Analysis Tree displays to the right. 
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Custom Layout 3 displays the Network Diagram, Analysis Tree, 
and Properties with tabs Output and Search. The Analysis Tree 
displays to the left.

The Reset Screen layout capability on the view menu enables you to 
return to these defaults at any time. For more information on how to move 
windows around, see “Manipulating Windows” on page 50.

Manipulating Windows

Any window in IMPRINT Pro that has a title bar is considered a Tool 
window, for example the Analysis Tree window. A tool window can be 
floating, docked, hidden, displayed in a vertical or horizontal tabbed format, 
and they have the auto-hide property.

Floating Windows
When a window is floating, you can move it around as a separate window 
that floats on top of the other windows. You can move a floating window 
outside of the main IMPRINT Pro window. 

To float a window:

1. Right-click the title of the window, such as Analysis Tree or Properties.
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2. Select Floating from the menu that displays so that a check mark 
appears adjacent to the Floating item.

The window appears as a separate window.

Making Windows Dockable
When a window is dockable, you can move it with the mouse so that it 
snaps to the closest side of the IMPRINT Pro window. 

To make a window dockable:

1. Right-click the title of the window, such as Analysis Tree or Properties.

2. Select Dockable from the menu that displays so that a check mark 
displays adjacent to the dockable item.

Docking Windows
Once you set a window to be dockable, you can dock it to any of the sides 
of the main IMPRINT Pro window. 

To dock a window:

1. Drag the window toward an edge of the IMPRINT Pro window to the 
location you want.

As you drag the outline of the dockable window, four blue orientation 
docking symbols appear, each at the outer edge of the IMPRINT Pro 
application window. By dragging the outlined window over one of these 
symbols, the window will become docked along that edge of the 
application window. Also, shown is a separate docking orientation key 
within the window over which the window outline is currently hovering. If 
you wish to set your window down in any part of this location, simply 
drag your mouse to the edge of the symbol corresponding to the edge 
of the window where you want your window docked. 

2. Release the mouse button.

When you dock a window over an existing window, both windows now 
exist in the same space, but only one can be viewable at a time. The 
user can then choose what window to view by clicking that window’s 
corresponding tab (located at the bottom of the window region.)
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Displaying Tab Groups
You can display tabbed windows adjacent to each other so that they can 
be viewed at the same time. 

To display a tab group:

1. Right-click the title of any tab in a tool window.

2. To display the tab in a horizontal format, select New Horizontal. To 
display the tab in a vertical format, select New Vertical Tab.
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The window rearranges to the selected format.

Repeat the previous step for any of the other windows as desired.
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Hiding Windows
Hiding a window completely removes the window from the display and 
frees up more working space. Hiding a window is the same as closing the 
window.

To hide a window:

1. Right-click the title of the window, such as Analysis Tree or Properties.

2. Select Hide from the menu that displays. You can alternatively click the 
 in the upper right corner of the window.

The window is removed from the display.

Redisplaying Hidden Windows
Once a window is hidden, you can redisplay it using the View menu.

To redisplay a hidden window:

1. From the View menu, select Windows.

2. Select the window.

The window redisplays in the last position it occupied.

You can also redisplay a window using the Windows tab. For details, 
see “Windows Pane” on page 38.
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Auto-Hiding Windows
Auto-Hide minimizes a window and places a tab with the window name on 
the closest edge of the IMPRINT Pro window. 

To enable Auto-Hide:

1. Right-click the title of the window, such as Analysis Tree or Properties.

2. Select Auto-Hide from the menu that displays.

You can alternatively click the push pin icon on the title bar of the 
window. The icon points to the left when Auto-Hide is enabled and 
down when Auto-Hide is disabled.

When you move the mouse and the focus to another window, the 
window in auto-hide mode minimizes, and a tab displays on the edge of 
the IMPRINT Pro window with its name.

Displaying Windows in Auto-Hide Mode
Windows in Auto-Hide mode display as tabs along the edge of the 
IMPRINT Pro main window. Each tab displays the name of the window it 
represents.
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To display a window in Auto-Hide mode:

Move the cursor over the window tab.

The window slides back into view and is ready for use. When you click 
the mouse off the window, the window loses focus and automatically 
slides back to the tab on the edge of the main window.

Disabling Auto-Hide Mode
Disabling Auto-Hide mode returns the window to its previous position.

To disable Auto-Hide mode:

1. Move the cursor over the tab for the window so that the window 
redisplays.

2. Right-click the window title and select Auto-Hide so that the check 
mark adjacent to it is cleared.

You can alternatively click the push pin icon on the title bar of the 
window. The icon points in a downward direction when auto hide is 
disabled.

Moving Windows
To move any window:

Click and drag the title bar of the window to the new location while 
holding down the left mouse button.

Resizing Windows
To resize any window:

Move the cursor over the border of a window until the cursor changes 
into a double-headed arrow.

Press the left mouse button and move the border to the new location.
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Changing the Active Window 
To make a window active:

1. Click anywhere in the window.

2. If the window is not currently displayed, do the following:

From the View menu, select Windows, and then select the window you 
want to make active.

Closing Windows
To close a window:

Click the in the upper right corner of the window or tab. You can 
alternatively right-click the title of the window and select Hide from the 
menu that displays.
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This chapter provides a detailed description of the menu items available in 
IMPRINT Pro. It is organized in the same order as the IMPRINT Pro menu 
items themselves, proceeding from left to right, top to bottom, beginning 
with the items on the File menu, and concluding with the items on the Help 
menu.

The menu bar displays below the title bar at the top of the IMPRINT Pro 
window and contains the File, Edit, View, Reports, Tools, Utilities and Help 
menu headings. Once a mission is opened, the menu bar expands to 
includes Moderators and Execution menu headings.

File Menu

The File menu has the following commands:

New Local Folder

New Analysis

Import Analysis

Library Analysis

New Analysis From Imported Data

Save Analysis

Save As

Close Current Analysis

Close All Except Current Analysis

Print

Exit
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New Local Folder 
In the Local Server directory of the Analysis Tree you can organize 
analyses into folders, much like you organize files into folders on your 
computer, by adding folders to the Analysis Tree.

To add a folder to the Analysis Tree:

From the File menu, click New Local Folder.

A new folder is added to the Analysis Tree under the Local Server 
node. You can rename the new folder with a double-click on the folder. 
Enter a new name in the Properties window. 

Analyses folders may also be added to the tree by right-mouse clicking 
anywhere in the Analysis tree and selecting the option New Local 
Folder.

Once the new folder displays, you can cut or copy any analysis from an 
existing folder and paste it to the new folder. The cut analysis will 
display in red in the Analysis tree until pasted into the new folder.

New Analysis
You can add a new analysis to any existing folder in the analysis tree.

To add a new analysis:

1. From the File menu, select New Analysis.

2. In the submenu which appears to the right, select the folder in the Local 
Server directory where you wish to add the new analysis.

The corresponding folder in the Analysis Tree automatically expands to 
display your newly added analysis.

New analyses may also be added to the tree by right-mouse clicking any 
folder in the Analysis tree and selecting the option New Analysis.

Import Analysis
You can import an analysis into any existing folder in the analysis tree.
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To import an analysis:

1. From the File menu, select Import Analysis.

2. In the submenu which appears to the right, select the folder in the Local 
Server directory where you wish to add the imported analysis.

The corresponding folder in the Analysis Tree automatically expands to 
display your imported analysis.

Imported analyses may also be added to the tree by right-mouse clicking 
any folder in the Analysis tree and selecting the option Import Analysis.

Library Analysis
You can add a library analysis into any existing folder in the analysis tree.

To add a library analysis:

1. From the File menu, select Library Analysis.

2. In the submenu which appears to the right, select the folder in the Local 
Server directory where you wish to add the library analysis.

The corresponding folder in the Analysis Tree automatically expands to 
display your added library analysis.

Library analyses may also be added to the tree by right-mouse clicking any 
folder in the Analysis tree and selecting the option Library Analysis.

New Analysis From Imported Data
You can create a new analysis from an imported data file.  Supported data 
file formats include the following:

Operations:

MMF Data (.mmf files)

Maintenance

Maintenance Spreadsheet (.maintPro files)

Maintenance LSA File (.txt files)
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These options are available through the File menu under the New 
Analysis From Imported Data submenu.

Note:
The option to import maintenance data into an analysis is available only to the 
user having the lock on the analysis. For more information on locking and 
unlocking analyses see IMPRINT Pro User Guide Volume 1 - Basic 
Procedures, Chapter 1: Basic Procedures, Understanding the Analysis 
Environment, Locking and Unlocking Analyses.

New Analysis from MMF Data
Operational Mission data created in the IMPRINT Pro MMF Mission 
Builder application may be imported into IMPRINT Pro as the start of a 
new analysis.

To import MMF data as a new analysis:

1. Open IMPRINT Pro.

2. From the File menu, select the New Analysis from Imported Data 
option.

3. From the submenu that appears, select the From MMF Data option.

4. From the submenu that appears, select Local Server.

5. From the submenu that appears, select the folder in which the new 
analysis should appear.

A browse dialog appears.

6. From the browse dialog, select the MMF data file (.mmf file) to import, 
and then click the Open button.

The data imports, and a message appears, indicating if the import was 
successfull or unsuccessful.

7. Click Ok.

8. The Analysis Tree displays the new analysis with the imported data.

Note:
MMF data may also be imported into an existing IMPRINT Pro analysis.  This 
option, however, is not available through the File menu option and is only 
available through the IMPRINT Pro analysis tree.
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To import MMF Data into an existing analysis:

1. Open up the IMPRINT Pro Analysis Tree.

2. Locate the analysis into which the MMF data file will be imported.

3. Right-mouse click the desired analysis, and then select the Import 
Data option from the submenu that appears.

4. Select MMF Data from the submenu that appears.

A browse dialog appears.

5. From the browse dialog, select the MMF data file (.mmf file) to import, 
and then click the Open button.

The data imports, and a message appears, indicating if the import was 
successfull or unsuccessful.

6. Click Ok.

7. The Analysis Tree displays the imported data under the selected 
analysis.

New Analysis from Maintenance 
Spreadsheet
For maintenance data which does not conform to an LSA template format, 
IMPRINT Pro includes a spreadsheet template into which your own 
maintenance data may be entered using Microsoft Excel. Once the data is 
entered, it may be saved to a file that can then be imported into an 
IMPRINT Pro as the start of a new maintenance analysis using the New 
Analysis from Imported Data option from the File menu.  

Alternatively, you may import maintenance spreadsheet data into an 
existing analysis, although this option is only available through the Analysis 
Tree and not through the File menu.

Before importing maintenance spreadsheet data, the data must first be 
created using the IMPRINT Pro Maintenance Template.

To create maintenance data using the IMPRINT Pro Maintenance 
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Template:

1. Locate the maintainance task template file, ImportIMPRINT.xlt, 
included with your installation of IMPRINT Pro. This file is located in the 
C:\Program Files\IMPRINT Pro\Templates directory by default.

Note:
You may be prompted by Excel that macros are currently disabled on your 
system. In order to use the maintenance task template, you must choose to 
enable your macros before proceeding with the next step.

2. Enter the Subsystem and Component information in the columns 
provided. This information is required by the template for each row of 
data entered. You may copy data from a separate tab-delimited or 
comma-delimited file, provided the data is ordered to match the rows 
and columns in the template, and provided the number of cells copied 
matches the number of cells for pasting.

3. In the remaining columns, enter data as required. Some data fields 
require you choose from a drop-down list (e.g., Usage Type). To access 
the list, simply click the cell, and then click the drop-down arrow which 
appears – a list of choices appears. Click any listed option to select it. 
Note: Subsystem ID and Component ID fields are optional and will 
display only in reports.

4. Any invalid entry entered into the template appear in red. Entries may 
be invalid due to too many characters in Subsystem or Component 
names, invalid characters (slashes, commas and colons) or entries that 
are not included in the list of expected values where drop-down lists are 
in place. All invalid data must be corrected before the template can be 
exported.

5. Click the Create Data Import File button at the top of the template. 

A dialog box appears, prompting you for a name and location to which 
your data export file is to be saved. If desired, click the Browse button 
to locate and select a new folder to which the file should be exported. 
Enter a name in the File name field. All exported template data 
automatically saves to a .maintPro (“maintenance import - IMPRINT 
Pro”) file format.

Note:
Note: a duplicate maintenance entry is any entry that has the same 
Subsystem-Component-Action-Type combination as an existing entry; before 
your maintenance data is exported for use by the IMPRINT Maintenance 
module, the template application checks for and eliminates all duplicate 
entries.
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To import Maintenance Spreadsheet data as a new analysis:

1. Open IMPRINT Pro.

2. From the File menu, select the New Analysis from Imported Data 
option.

3. From the submenu that appears, select the From Maintenance 
Spreadsheet option.

4. From the submenu that appears, select Local Server.

5. From the submenu that appears, select the folder in which the new 
analysis should appear.

A browse dialog appears.

6. From the browse dialog, browse to the place in your directory structure 
where you have stored the desired maintenance template data file, and 
then select the template data file (.maintPro) to import.  

7. Click the Open button.

Once you have selected the file to import, IMPRINT Pro automatically 
detects the format of your file and proceeds to import the data into the 
equipment side of your analysis. If IMPRINT identifies any duplicate 
record, it will keep the duplicate but append a unique numeric identifier 
to it (e.g., “[1]” or “[2]”) in order to ensure that all component names are 
unique. If IMPRINT identifies duplicate records that have different 
specialties, the records will be kept in your data set.

The subsystems and components added to IMPRINT Pro are case 
sensitive. If an imported maintenance task data set contains identical 
subsystem and component names as those already existing in the 
analysis, the duplicates will be stripped during the import and any 
original data entered in the analysis through IMPRINT Pro will not be 
overwritten by the imported data. All data unique to the subsystem and/
or component which is not included in the original data in the analysis, 
however, will be added in from the Maintenance Task Template import 
file upon import.

8. Review and edit the imported data as desired. You will find your data 
under the “Define Equipment” option or under the “Options” menu 
“Review Task Data” menu item, “Maintenance” selection.
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To import Maintenance Spreadsheet data into an existing analysis:

1. Open IMPRINT Pro.

2. In the Analysis Tree open/expand the desired analysis into which LSA 
maintenance data will be imported.

3. Right-mouse click the analysis.

A shortcut menu appears.

4. From the shortcut menu, selec the Import Data option.

5. From the submenu that appears, select the Maintenance Template 
Data option.

A browse dialog appears.

6. From the browse dialog, browse to the place in your directory structure 
where you have stored the desired data file, and then select the 
template file (.maintPro file) to import.  Then, click the Open button.

Once you have selected the file to import, IMPRINT Pro automatically 
detects the format of your file and proceeds to import the data into the 
equipment side of your analysis. If IMPRINT identifies any duplicate 
record, it will keep the duplicate but append a unique numeric identifier 
to it (e.g., “[1]” or “[2]”) in order to ensure that all component names are 
unique. If IMPRINT identifies duplicate records that have different 
specialties, the records will be kept in your data set.

The subsystems and components added to IMPRINT Pro are case 
sensitive. If an imported maintenance task data set contains identical 
subsystem and component names as those already existing in the 
analysis, the duplicates will be stripped during the import and any 
original data entered in the analysis through IMPRINT Pro will not be 
overwritten by the imported data. All data unique to the subsystem and/
or component which is not included in the original data in the analysis, 
however, will be added in from the Maintenance Task Template import 
file upon import.

7. Review and edit the imported data as desired. You will find your data 
under the “Define Equipment” option or under the “Options” menu 
“Review Task Data” menu item, “Maintenance” selection.
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New Analysis from Maintenance LSA File
IMPRINT Pro provides the option for importing Logistics Systems Analysis 
(LSA) Reports as the start of a new analysis using the New Analysis from 
Imported Data option from the File menu.  These reports, usually 
containing maintenance data broken out by subsystem and component, 
import into the Maintenance side of your analysis under the Equipment 
node.  

Alternatively, you may import maintenance LSA data into an existing 
analysis, although this option is only available through the Analysis Tree 
and not through the File menu. 

IMPRINT accepts three different LSA formats. These include 750-16, 
1388-2A and 1388-2B formats. The first two formats accept the data from 
the “02” report. The 1388-2B format accepts data from the “01” report. 
These are standard formats.

Before you import an LSA file, some preparation must be conducted. First, 
make sure your data are in ASCII text files. Most likely, you will receive 
your LSA report in a Word document. If this is the case, follow the steps 
below before attempting to import the data.

To prepare an LSA file for import into IMPRINT Pro:

1. Open the file in Microsoft Word.

2. Select the entire file, and change the font to Times New Roman, and 
the size to 6 point. This should remove the wrap-around from your data 
records. You do not need to make any other modifications to the file.

3. Save the file as a text file, with line breaks. Make sure the extension is 
*.txt. 

To import LSA Maintenance data as a new analysis:

1. Open IMPRINT Pro.

2. From the File menu, select the New Analysis from Imported Data 
option.

3. From the submenu that appears, select the From Maintenance LSA 
File option.

4. From the submenu that appears, select Local Server.
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5. From the submenu that appears, select the folder in which the new 
analysis should appear.

A browse dialog appears.

6. From the browse dialog, browse to the place in your directory structure 
where you have stored the *.txt file, and then select the LSA data file 
(.txt file) to import.  Then, click the Open button.

The data imports, and a message appears, indicating if the import was 
successfull or unsuccessful.

7. Click Ok.

Once you have selected the file to import, IMPRINT Pro automatically 
detects the format of your file and proceeds to import the data into the 
equipment side of your analysis. If IMPRINT identifies any duplicate 
record, it will keep the duplicate but append a unique numeric identifier 
to it (e.g., “[1]” or “[2]”) in order to ensure that all component names are 
unique. If IMPRINT identifies duplicate records that have different 
specialties, the records will be kept in your data set.

Review and edit the imported data as desired. You will find your data 
under the “Define Equipment” option or under the “Options” menu 
“Review Task Data” menu item, “Maintenance” selection.

To import LSA Maintenance data into an existing analysis:

1. Open IMPRINT Pro.

2. In the Analysis Tree open/expand the desired analysis into which LSA 
maintenance data will be imported.

3. Right-mouse click the analysis.

A shortcut menu appears.

4. From the shortcut menu, selec the Import Data option.

5. From the submenu that appears, select the Maintenance LSA Data 
option.

A browse dialog appears.
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6. From the browse dialog, browse to the place in your directory structure 
where you have stored the *.txt file, and then select the LSA data file 
(.txt file) to import.  Then, click the Open button.

Once you have selected the file to import, IMPRINT Pro automatically 
detects the format of your file and proceeds to import the data into the 
equipment side of your analysis. If IMPRINT identifies any duplicate 
record, it will keep the duplicate but append a unique numeric identifier 
to it (e.g., “[1]” or “[2]”) in order to ensure that all component names are 
unique. If IMPRINT identifies duplicate records that have different 
specialties, the records will be kept in your data set.

Review and edit the imported data as desired. You will find your data 
under the “Define Equipment” option or under the “Options” menu 
“Review Task Data” menu item, “Maintenance” selection.

Save Analysis
We recommend that you save your analysis often! 

To save the changes you have made to your analysis:

1. Select the analysis in the tree that you wish to save by clicking it.

2. From the File menu, click Save Analysis.

Your analysis saves to the name and version which display in the 
Analysis tree and Properties window.

Note:
Each time you run an operational mission or a maintenance scenario, your 
analysis automatically saves to the database just prior to the model run.

Save As
To save your analysis under a new name: 

1. From the File menu, click Save As to enter a new analysis name and/or 
version.

2. In the Save Analysis As dialog box which appears, enter in the new 
name and/or version to which your analysis should be saved.
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3. Click the Ok button.

The new analysis name and/or version appears in the analysis tree and 
properties window.

Note:
The Ok button is disabled until the default name and/or version in the dialog 
box is changed.

Close Current Analysis
The Close Current Analysis option collapses the currently-selected 
analysis in the Analysis Tree and empties the IMPRINT Pro display 
windows.

To close the current analysis:

From the File menu, click Close Current Analysis.

Prior to the analysis closing, you will be asked if you wish to save the 
analysis. Upon selecting Yes, the analysis saves and closes. Upon 
selecting No, the analysis closes without saving.

Close All Except Current Analysis
The Close All Except Current Analysis option closes all analyses in the 
Analysis Tree except for the currently-selected analysis.
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To close all analyses except the current analysis:

From the File menu, click Close All Except Current Analysis.

For each analysis which must be closed, you will be asked if you wish to 
save the analysis prior to closing it. Upon selecting Yes, these analyses 
save and close. Upon selecting No, these analyses close without 
saving. The currently-selected analysis remains open.

Print
The Print option allows you to print the network diagram in three different 
ways:

Entire Network. Print the entire network diagram. 

Selected. Print only the currently-selected nodes and paths in 
the network diagram.

Visible. Print only the portion of the network diagram which is 
currently visible in the Network Diagram window.

For details on printing, see Chapter 4, “Mission Analyses,” in Volume 2 
of the IMPRINTPRO User Guide.

To print a network diagram selection:

1. Click the Network Diagram, or else select the components from the 
network diagram you wish to print.

2. From the File menu, select Print...

The Print Network dialog box displays.
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3. Choose a print option by clicking the drop-down arrow and selecting an 
option from the list.

A Print Preview window appears.

4. Modify the preview and print settings as required, and then click the 
Print icon  to print your network diagram selection.

Note:
Users with Adobe Acrobat installed on their systems may print to PDF 
provided this option displays in the list of available printers (see the Printers 
option under the Page Setup window.)
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Exit
To close IMPRINT Pro:

From the File menu click Exit. Alternatively, click the  in the upper 
right corner of the window.

Edit Menu

The Edit menu has the following menu items:

Undo

Redo

Cut

Copy

Paste

Copy Diagram as Image

Clear Output

Preferences

Undo
The Undo feature in IMPRINT Pro allows you to undo the last action 
performed in the IMPRINT Pro interface. This feature may be used on any 
action which adds or deletes data from the IMPRINT Pro database. 
Examples include the following:

Adding and deleting nodes from the tree or network.

Renaming nodes.

Adding or deleting data from the properties of any node. 

A separate Undo history is kept for each individual analysis in the Analysis 
Tree. For each analysis, the Undo action may be used as many times as 
there are actions which can be undone.
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The Undo feature may not be used to reverse the following actions:

Saving analyses.

Deleting analyses from the tree.

Deleting folders from the tree which contain analyses.

Running a model.

Reconfiguring a change made to the window layout.

To undo an action:

1. Confirm the analysis whose last action you wish to undo is selected in 
the Analysis Tree.

2. Click the Undo button in the IMPRINT Pro tool bar. Alternatively, you 
may select the Undo option from the Edit menu.

The last action in the selected analysis is reversed.

Redo
The Redo feature in IMPRINT Pro allows you to reverse a change made by 
the Undo command. A separate Redo history is kept for each individual 
analysis in the Analysis Tree. For each analysis, the Redo action may be 
used as many times as there are actions which have been undone.

To redo an action:

1. Confirm the analysis whose last action you wish to redo is selected in 
the Analysis Tree.

2. Click the Redo button in the IMPRINT Pro tool bar. Alternatively, you 
may select the Redo option from the Edit menu.

The last action undone in the selected analysis is redone.

Cut
You can cut text and objects using the Cut command. Cutting places the 
text or object on the clipboard where it may then be pasted elsewhere in 
the analysis or in another application. Once the item is pasted, it is 
removed from its original location.
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To cut text or an object:

1. Select the text or object to cut.

2. From the Edit menu, click Cut.

You may alternatively right-click the item to be cut and select Cut from 
the shortcut menu.

The cut item is copied to the clipboard. You can now paste this item 
elsewhere in IMPRINT Pro or in another application.

Copy
You can copy selected text or an object to the Windows clipboard. Copying 
an object copies all of the object’s properties. Once the text or object is on 
the clipboard, you can use the Paste command to insert it elsewhere in the 
analysis or into another application. 

To copy text or an object: 

1. Select the text or object to copy.

2. From the Edit menu, click Copy. You can alternatively right-click the 
mouse and click Copy.

The item is copied to the clipboard.

Paste
You can paste items copied to the clipboard with the Paste command. If 
the clipboard is empty, or if the current clipboard item is not in a format 
appropriate for the current location, the Paste command appears dimmed 
so that you cannot select it. You cannot use the Paste command to replace 
a network that is currently displayed or any network above it. 

To paste text or an object do one of the following:

1. Click the destination of the item to be pasted, for example if choosing to 
paste a copied task from one function to another, click the destination 
function.
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2. From the Edit menu, click Paste.

You may alternatively right-click the destination of the item to be pasted 
and select Paste from the shortcut menu.

The pasted text or object displays. For objects on the network diagram, 
the pasted object is on top of the copied object. IMPRINT Pro 
automatically assigns a new ID to the item, but the name is the same as 
the copied item.

For a node in the network diagram, select the node, and use the mouse 
to move it to the new location.

Copy Diagram as Image
You can copy an entire network diagram to the Windows clipboard and 
paste the copy into another application. Only the graphical depiction of the 
network is copied. You cannot paste the diagram into IMPRINT Pro.

To copy a network diagram:

1. Select the Network Diagram whose image is to be copied.

2. From the Edit menu, click Copy Diagram as Image.

You may alternatively right-click in the network diagram and select 
Copy Diagram as Image from the shortcut menu.

The network diagram is copied to the clipboard. You can now paste the 
contents into another application.

Clear Output
You can clear or remove the existing results in the Output window using 
the Clear Output command. The Output window clears itself prior to the 
beginning of each model run you initiate. If you want to save the results for 
a single simulation, be sure to save the results prior to clearing the window 
or beginning another model run.
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To clear the Output window:

From the Edit menu, click Clear Output.

Alternatively you may right-click inside the Output window and choose 
the Clear Output option.

The Output window clears. 

Preferences
Use this menu item to alter your settings for Specialty type; Time Display 
format; Temperature Scale; Task, Function and Goal shapes and colors; 
and Maintenance Org Levels. These settings, also known as “preferences”, 
are saved at the analysis level.

To change your IMPRINT Pro settings:

1. Select the mission in the Analysis Tree whose settings you wish to 
change.

2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the tab corresponding to the preference item you wish to change.

Alter preferences in the tab as desired, and then click Ok to save.
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Specialty
The Specialty tab allows you to choose the military branch whose list of 
specialties you wish to select from when selecting warfighter operators, 
maintainers and supply/support personnel. 

To set a specialty:

1. Select the mission in the Analysis Tree whose specialty type you wish 
to set.

2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Specialty tab.

4. Click the radio button of the specialty you wish to set. Options include 
Army, Navy, Air Force, Marine Corps and Joint (all branches).

5. Click the OK button.

All specialty lists in IMPRINT Pro are filtered according to the selected 
specialty type.

Time
The time option allows you to choose the time display format you wish to 
use when entering data in the IMPRINT Pro and when viewing data in the 
IMPRINT Pro reports. You may use different format types among the 
Operations, Maintenance and Forces parts of your analysis. Options 
include HH:MM:SS.mm, Hours, Minutes and Seconds for the Operations 
and Maintenance modules and Hours, Minutes and HH:MM for the Forces 
module. 

To set a time format:

1. Select the mission in the Analysis Tree whose time format you wish to 
set.

2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Time tab.
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4. Choose the display and/or report category(ies) whose time format you 
wish to change.

5. Below it, click the radio button of the time format you wish to set for that 
category. 

6. Click the OK button.

All IMPRINT Pro interfaces and reports update to display time in the 
selected formats.

Temperature
The Temperature option allows you to specify the temperature scale you 
wish to use when selecting temperature stressors from the Performance 
Moderators dialog. 

To set a temperature format:

1. Select the mission in the Analysis Tree whose temperature format you 
wish to set.

2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Temperature tab.

4. Choose the temperature scale you wish to use by clicking the 
corresponding radio button. Options include Celsius and Fahrenheit.

5. Click the OK button.

All options for temperature in the Performance Moderator Stressors 
dialog display temperature in the selected scale.

Shapes and Colors
The Shapes and Colors option allows you to set the shapes, sizing and 
colors of the nodes used in your network diagram (Operational missions 
only). These settings are applied to tasks, functions, goals and comments.

To edit the shape of a node:

1. Select the mission in the Analysis Tree containing the nodes whose 
shape(s) you wish to modify.
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2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Shapes and Colors tab.

4. From the Select Node Type drop-down box, click the arrow on the 
right-hand side of the box to view a list of nodes from which to choose.

5. Select the node you wish to edit by clicking it in the list.

The tab updates to display all default settings for the selected node.

6. Next to the Shape box, click the drop-down box for a list of selectable 
shapes. Options include Rectangle, Cube, Cylinder, Ellipse, 
Hexagon, Diamond, Octogon, Parallelogram, Rounded Rectangle, 
Right Arrow, Left Arrow, Up Arrow, Down Arrow, TrapezoidLeft 
and TrapezoidRight.

7. Select a shape by clicking it.

The tab updates to display all default settings for the newly selected 
node.

8. Click the OK button.

All corresponding nodes in your network diagram update to display the 
selected shape.

To edit the size of a node:

1. Select the mission in the Analysis Tree whose nodes you wish to resize.
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2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Shapes and Colors tab.

4. From the Select Node Type drop-down box, click the arrow on the 
right-hand side of the box to view a list of nodes from which to choose.

5. Select the node you wish to edit by clicking it in the list.

The tab updates to display all default settings for the selected node.

6. Next to the Size box, click the drop-down box for a list of size options. 
Options include:

Fit to Text. All corresponding nodes in the network diagram 
resize automatically to display the full node name.

Resizable. All corresponding nodes in the network diagram 
remain their original size until modified. You may modify the size 
of the node by clicking and dragging the green handles which 
appear when the node is selected in the network diagram. Only 
one node resizes at a time using this method.

7. Click the OK button in the Preferences window.

All corresponding nodes in your network diagram update to use the 
selected size preference.

To edit the color of a node:

1. Select the mission in the Analysis Tree whose color you wish to 
customize.

2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Shapes and Colors tab.

4. From the Select Node Type drop-down box, click the arrow on the 
right-hand side of the box to view a list of nodes from which to choose.

5. Select the node you wish to edit by clicking it in the list.

The tab updates to display all default settings for the selected node.
81



IMPRINT Pro Basic Procedures
6. Next to the Color box, click the drop-down arrow for a list of selectable 
colors. Select a new color from the palette which displays.

OR

Click the More Colors... button to customize your own node color. In 
the Select Color dialog which appears, choose your new color by 
selecting from the list on the left, by using the RBGA sliders at the 
bottom of the dialog or by clicking the location of the approximate 
desired color on the color wheel. Once the box at the bottom of the 
Select Color dialog displays your desired color, click the OK button.

7. Click the OK button in the Preferences dialog.

All corresponding nodes in your network diagram update to display the 
selected color.

Maintenance Org Levels
The Maintenance Org Levels option allows you to customize the names of 
the three org levels used in repair task data in your equipment analysis. 
Regardless of the names you choose for your Org levels, level 1 may only 
be performed “on” equipment while level 3 may only be performed “off” 
equipment; level 2 may be performed either “on” or “off” equipment. Default 
names for Org levels 1, 2 and 3 are Org, DS and GS, respectively.

To edit a Maintenance Org Level:

1. Select the mission in the Analysis Tree whose Maintenance Org Levels 
you wish to customize.

2. From the Edit menu, click Preferences.

A Preferences dialog window appears.

3. Click the Maintenance Org Level tab.

4. Choose the level whose name you wish to change, and then type in the 
new name in the box to the right.

5. Click the OK button.

The modified org level names appear in the Org Level drop-down box 
in the Repair Task dialogs and in the Maintenance reports.
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View Menu

The View menu contains the following commands:

Diagram Zoom

Windows

Layout

Diagram Zoom
Use the Zoom feature of IMPRINT Pro to view a specific part of the 
diagram in detail or broaden the diagram view.

To zoom the network diagram:

1. From the View menu, click Diagram Zoom.

2. Select the magnification level. Magnification levels vary from 25% to 
800%.

The Network Diagram grows/shrinks accordingly inside the Network 
Diagram window.

Alternatively you may zoom the Network Diagram by holding the 
Control key down while rolling the mouse wheel. Large network 
diagrams may be panned by holding down the Shift key while rolling 
the mouse wheel. The Network Diagram window must first be selected 
before these options are enabled.

Windows
Use this menu to display any IMPRINT Pro window that is currently hidden 
or closed. For more details on individual windows, see “Windows” on 
page 38.

To view a window:

1. From the View menu, click Windows.

A submenu displaying all viewable windows appears.
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2. Click the window you wish to view.

The selected window comes into view in the IMPRINT Pro interface.

Analysis Tree. Select Analysis Tree to view a hierarchical list of 
the analyses.

Animator. Select the Animator window to view a two-
dimensional animation of the model executing (maintenance 
model only).

Event Queue. Select Event Queue to display the list of events 
as they occur during model execution. These include the 
execution of tasks and scheduled events.

Network Diagram. Select Network Diagram to view the 
graphical depiction of the task network developed under the 
Mission module.

Output. Select Output to view the trace of the execution, which 
consists of the actions that occur when you run the model.

Palette. Select Palette to view the tools you use to construct a 
network diagram.

Properties. Select Properties to view a window that displays the 
properties of the model item selected in the network diagram, 
such as function, task, or goal. It also displays the properties of 
items that you select in the tree view such as variables, macros, 
scenario events, charts, and snapshots.
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Search and Replace. Select Search and Replace to locate a 
string of text in the model and to optionally replace select 
instances of that string with a new string you specify. 

Variable Watches. Select Variable Watches to monitor the 
values of variables as a model executes. Viewing the values of 
variables in the model can be an excellent tool for debugging.

Windows. Select Windows to view a list of all windows you can 
display in IMPRINT Pro. This window is intended to be a shortcut 
to quickly open other display windows by simply clicking their 
corresponding icons and is identical in functionality to the View - 
Windows menu option.

Layout
IMPRINT Pro allows you to modify your window configurations as desired. 
and to save up to three specific layouts. The Layout menu contains 
commands to reset the screen layout to one of the these configurations:

Custom Layout 1 

Custom Layout 2

Custom Layout 3

Each layouts represent the last-known configuration of the windows when 
the layout was last chosen in the IMPRINT Pro environment. 

To change the screen layout:

1. Click the View menu.

2. Click the layout you wish to restore.

The IMPRINT Pro windows display in the new layout.

The Layout menu also includes the command Reset Screen Layout. 
This option allows you to restore the layout you have modified to the 
original default version of the layout included with IMPRINT Pro.

To reset the screen layout:

1. Click the View menu.
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2. Click the Reset Screen Layout option.

The layout restores to the original default IMPRINT Pro configuration for 
that specific custom layout number.

For more information on customizable default configurations please refer to 
“Window Configurations” on page 48.

Moderators Menu

Below this menu you will find IMPRINT Pro’s capability to apply taxons, 
Personnel, Training and Stressor settings to tasks for Operational or 
Maintenance models.

Map Workload to Taxons

Map Maintenance Tasks to Taxons

Settings

Results

Map Workload to Taxons
Taxons provide a method for you to describe the composition of your task. 
Taxons are used in IMPRINT Pro to adjust estimated task times and 
accuracies when you apply Personnel Characteristics, Training Frequency 
or Stressor adjustments. 

If you do not want to enter taxons, but you have already entered workload 
assignments you can use the Map Workloads to Taxons capability. 

To map workload to taxons:

Click Map Workload to Taxons from below the Moderators menu.

View the summary of the effects of the command in the Output window.

IIMPRINT Pro automatically maps taxon weights to the repair tasks in a 
maintenance scenario. The Map maintenance Tasks to Taxons dialog 
allows you to modify the mapping of taxons and taxon values for 
maintenance tasks. You can return to the default values set by IMPRINT 
Pro by clicking on the Reload Defaults button at the bottom of the dialog. 
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Modifying the taxons is only one part of using them. Taxons work in 
conjunction with stressors assigned to repair task types to impact 
calculated repair task times. 

Example: In the Maintenance Task Taxon Mappings dialog, show 
below, the repair task called “Adjust and Repair” involves some fine 
motor discrete action. On the stressor by taxon table on page 95 you 
can see that the stressor “COLD” affects the task time of a task 
involving a fine motor discrete action. Applying this stressor will impact 
the repair task time because of the nature of the task.

Map Maintenance Tasks to Taxons
To map maintenance tasks to taxons:

1. Click Map Maintenance Tasks to Taxons below the Moderators 
menu.

The Map Maintenance Tasks to Taxons dialog displays.

2. Do one or more of the following:

Adjust taxons by clicking the drop down arrow to the right of the 
Taxon box, and then select a taxon from the list that displays.
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Adjust taxon weight by clicking in the Taxon Weight box, and 
then type a new value.

Return to default values by clicking the Reload Defaults button.

Note:
To see the impact of taxons on the task times, you need to remember to set 
stressors on the “Stressors” dialog in the Moderators menu, and check the 
PTS Adjustments box in the Executions Settings menu before you run the 
model.

Settings
You can set Personnel Characteristics, Training Frequency, and Stressors 
(PTS) values under this IMPRINT Pro option for tasks in both Operational 
and Maintenance models. We recommend that you apply these attributes 
in the same order as how they are presented in the menu items and the 
interface (that is, Personnel, then Training, then Stressors). This is 
because the algorithms within IMPRINT Pro that make use of this 
information are order-dependent. Personnel Characteristics, the first set of 
Performance moderators, describe the attributes with which the Warfighter 
who will man your system will arrive. Next, the training for this Warfighter 
must be defined, and its effects will vary according to the Personnel 
attributes you just set. Finally, when the Warfighter actually performs the 
tasks, he or she will be subjected to environmental stressors. The impact of 
these stressors will also be dependent on moderators set before it.

In all of these effects, IMPRINT Pro calculates the impact of PTS variable 
change on the estimated task performance (time and accuracy). The 
amount of impact is reported to you. If you then execute the maintenance 
or operations model with the PTS Adjustments option checked, these 
“moderated” performance times and accuracies will be used by the model. 
If you do not check the PTS Adjustments option, then the model will 
execute with the original task time and accuracy estimates that you entered 
under the Mission interfaces.

Specific technical information regarding the precise algorithms that are 
used in this module, as well as the source of these algorithms can be found 
in Adkins and Dahl (1993) and in a paper included in Appendix A of the 
IMPRINT Pro User’s Guide.
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Personnel Characteristics
The Personnel Characteristics option allows you to change the Armed 
Services Vocational Aptitude Battery (ASVAB) composite score and the 
cutoff score for any specialty performing tasks in your model. The ASVAB 
is a battery of tests administered to enlistees prior to entering the military 
services, the scores of which are used by IMPRINT Pro to describe the 
personnel characteristics of Warfighters. By changing the ASVAB 
composite and cutoff scores, you are, in effect, changing the specialty. This 
is because you have redefined the minimum requirements of that specialty 
when it is selected to perform tasks. By selecting higher score minimums in 
these categories, your selected specialty might be more difficult to find. 
However, a specialty having higher scores might perform the task better 
than the same specialty having lower score minimums.

To edit the Personnel Characteristics settings:

1. From the Moderators menu, select the Settings... option.

2. In the submenu which appears, select the Personnel... option.

The Personnel Characteristics dialog box appears.

3. At the top of the dialog box, select the tab corresponding to the list of 
Warfighters whose characteristics you wish to view and edit. Options 
include Mission and Maintenance. Choose the Mission tab if you wish 
to modify ASVAB Composite and Cutoff values for operators; choose 
the Maintenance tab to modify the same for maintainers in your 
analysis.
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4. For either tab you select, a list all warfighters displays. Warfighters are 
sorted by Specialty and name. Accompanying each Warfighter listed is 
a default ASVAB Composite and ASVAB Cutoff score. Change the 
desired composite or cutoff values as follows:

To change the Composite value, insert the cursor in the box whose 
value you wish to change, and then choose a value from the drop-down 
list provided.

To change the Cutoff value, insert the cursor in the box whose value 
you wish to change, and then type in the desired value.

Alternatively, you may copy and paste values to and from Microsoft 
Excel provided the values shared are within the expected ranges for 
that category.

Note:
If you go back to the Task information (either under Equipment or Mission) 
and change the Specialty assignment, IMPRINT Pro will connect the baseline 
performance time and accuracy estimates you make to that Specialty. The 
only way to “simulate” a new Specialty assignment and the impact it will have 
on task performance is through reassigning the ASVAB composite and cutoff 
on these screens.

Mission Tab

Specialty. A 3-letter designation for a particular military job 
within the Armed Forces.

Warfighter. A person or automatic device that operates, 
maintains, supplies or supports military equipment.

ASVAB Composite. This option allows you to change the 
Armed Services Vocational Aptitude Battery (ASVAB) composite 
for the Specialty performing the tasks. The ASVAB itself consists 
of 10 subtests from which “composites” are constructed by 
combining two or more of the subtests. The current ASVAB 
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composite used to select people for the Specialty (for example, 
CO, EL, GM, etc.) is shown initially in the dialog box. You can 
select another ASVAB composite to be used from a drop down 
menu that will appear when you click the drop down control.

When choosing an ASVAB composite cutoff score, you should 
realize that a higher cutoff score will generally result in better 
performance within the Specialty. However, there will be fewer 
people available that can attain the higher cutoff score.

ASVAB Cutoff. This option allows you to change the Armed 
Services Vocational Aptitude Battery (ASVAB) composite cutoff 
score for the Specialty performing the tasks. The current ASVAB 
cutoff score used to select people for the Specialty is shown 
initially in the dialog box. You can edit this value by selecting a 
different cutoff value from the drop down menu that will appear 
by clicking on that control. Higher cutoff scores will normally 
result in better performance but will cause fewer people to be 
available for the Specialty.

Note:
To review the effect your selected composite and cutoff scores will have on 
your tasks, click Results from the Settings option on the Moderators menu to 
see a report summarizing the impact that your choice has had on task 
Accuracy, Time, and the Probability of achieving the minimum acceptable 
accuracy.

Maintenance Tab

Specialty. A 3-letter designation for a particular military job 
within the Armed Forces.

ASVAB Composite. This option allows you to change the 
Armed Services Vocational Aptitude Battery (ASVAB) composite 
for the Specialty performing the maintenance tasks. 

ASVAB Cutoff. This option allows you to change the Armed 
Services Vocational Aptitude Battery (ASVAB) composite cutoff 
score for the Specialty performing the tasks.
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Training
This option allows you to review and edit training frequencies that will 
applied to tasks. One of five training levels can be assigned to a task. You 
should choose the training level which best describes how often operators 
or maintainers will perform the task. Performance of the task could be part 
of a training exercise or actual job performance. In general, the more 
frequently an individual practices or performs a task, the more accurately 
they will perform it. In addition, an increase in training frequency normally 
will decrease the time required to perform the task.

If you are trying to improve task performance to meet accuracy or time 
requirements, increasing training frequency is one possible alternative. An 
increase in traIning frequency, however, will often require additional 
resources (for example, an increase in the frequency with which 
warfighters zero the sights of their weapons will require more ammunition).

To edit the Training settings:

1. From the Moderators menu, select the Settings... option.

2. In the submenu which appears, select the Training... option.

A dialog box appears, displaying a list all warfighters in your model by 
Specialty and Warfighter name. Accompanying each listing is a training 
frequency.
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3. To change the New Frequency value, insert the cursor in the box 
whose value you wish to change, and then choose a value from the 
drop-down list provided.

Alternatively, you may copy and paste values to and from Microsoft 
Excel provided the values shared are within the expected ranges for 
that category.

Note:
If you do not assign sustainment training frequencies to tasks, the average 
(that is once a month) will be assigned automatically.

It is important to note that any training frequency changes that you make 
may alter the stored accuracy, time, and/or probability values that 
IMPRINT Pro has for that particular task or Specialty, within your analysis. 
If you make training frequency changes, IMPRINT Pro will produce a 
“Delta” Report that will show you how task performance has been changed. 
When this “Delta” Report is produced, you should save the contents of this 
report (by selecting the data in the report using your mouse, and then 
pressing “Ctrl” for copy, going to Excel and pressing “Ctrl” for paste) in 
order to maintain a record of your changes. This record is important 
because you can make further changes in other places in IMPRINT Pro. As 
these changes add up, it can be difficult, if not impossible, to regain your 
initial values. You should save any subsequent “Delta” Reports as well.

Stressors
This option allows you to apply stressors to mission and maintenance 
tasks. Five different stressors can be applied to tasks. They include the 
following:

Cold. This option allows you to change the temperature and 
wind speed for the environment in which individuals are 
performing operator and maintainer tasks. 

Heat. This option allows you to change the temperature and 
humidity for the environment in which individuals are performing 
operator and maintainer tasks. 

Noise. This option allows you to change the decibel level at the 
ear and the distance between communicators for the 
environment in which individuals are performing operator and 
maintainer tasks. 
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MOPP Levels. Mission Oriented Protective Posture (MOPP gear 
for individual nuclear, biological, and chemical defense affects 
the time that it takes to complete tasks. MOPP level 0 has a 
degradation factor of 1 that correlates to “no degradation.” 
Degradation factors are applied as multipliers against the time 
that it takes to complete a task in BDUs. The most degraded 
performance is under MOPP 4 for fine motor discrete tasks and 
for oral communication tasks that take 1.7 times as long to 
perform.

Sleepless Hours. This option allows you to change the number 
of hours since sleep last occurred for individuals who are 
performing operator and maintainer tasks.

Whole Body Vibration. This option allows you to factor vibration 
into your model, which is likely to be encountered in the situation 
of sea state or in a vehicle driving along a bumpy road. The 
parameters for vibration are Frequency (HZ) and Magnitude (m/
s^2). The Whole Body Vibration stressor represents vibration for 
the z-axis (vertical) component only. 

Several stressors include both a primary and a secondary component to 
set:

For these three stressors, primary stressor component values must be 
set before the secondary stressor component fields become available 
for editing. Secondary stressor components may not be applied by 
themselves.

Stressors may be reviewed and changed for each individual task one at a 
time, or for an entire group of tasks all at once. Depending upon the 
specifics of the task and Specialty, adding stressors may decrease task 
accuracy and/or increase the time it takes to complete the task. 

In order to see the effects of stressors you should apply them one at a time. 
Once you have finished applying a stressor, it is recorded for that particular 
Task or Specialty and can be referred to or edited later.

Stressor Primary Component Secondary Component

Cold Temperature (degrees) Wind (knots)

Heat Temperature (degrees) Humidity (%)

Noise Distance (feet) Decibels

Whole Body 
Vibration

Frequency (Hz) Magnitude (m/s^2)
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It is important to note that any stressors that you apply may alter the stored 
accuracy, time, and/or probability values that IMPRINT Pro has for that 
particular task or Specialty, within your model. If you apply stressors, 
IMPRINT Pro will produce a “Delta” Report that will show you how task 
performance has been changed. When this “Delta” Report is produced, you 
should save the contents of this report (by selecting the data in the report 
using your mouse, and then pressing “Ctrl” for copy, going to Excel and 
pressing “Ctrl” for paste) in order to maintain a record of your changes. 
This record is important because you can make further changes in other 
places of IMPRINT Pro. As these changes add up, it can be difficult, if not 
impossible to regain your initial values. You should save any subsequent 
“Delta” Reports as well.

The following table indicates the impact of stressors by taxon.

T = Affects task time
A = Affects task accuracy
TA = Affects both

TAXON MOPP Heat Cold Noise Sleepless 
Hours

Visual T A T

Numerical A TA

Cognitive A TA

Fine Motor 
Discrete

T A T

Fine Motor 
Continuous

Gross Motor 
Light

T T

Gross Motor 
Heavy

Communication 
(Read & Write)

A

Communication 
(Oral)

T A A
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If you apply more than one stressor to the same task, then a power function 
is applied. This means that the most severe stressor will have full effect, 
and the others have less. More information regarding the relevant 
calculations can be found in the HARDMAN III Final Report (Adkins and 
Dahl, 1993).

To edit the Stressor settings:

1. From the Moderators menu, select the Settings... option.

2. In the submenu which appears, select the Stressors... option.

A dialog box appears, displaying a list all tasks in your model. 

3. To change a stressor setting, insert the cursor in the box whose value 
you wish to change, and then choose a value from the drop-down list 
provided. For stressors having both a primary component and a 
secondary component set the primary component first, after which the 
secondary component may be set. Secondary components may not be 
applied by themselves.

Alternatively, you may copy and paste values to and from Microsoft 
Excel provided the values shared are within the expected ranges for 
that category.

Results
Use the Results... option to review any impact on task performance as a 
result of applying Personnel Characteristics, Training, or Stressor 
moderators to either a Mission or Maintenance model.

To view the impact of PTS settings on your tasks: 

1. From the Moderators menu, select the Results... option.

A dialog box displays, listing all tasks and their respective PTS settings.

2. On the right-hand side of the dialog box are three check boxes: 
Personnel Characteristics, Training and Stressors. Check the boxes of 
the moderators you wish to apply to your tasks.
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3. Click Apply on the PTS Results dialog. 

Once you “Apply” your choices, you will see a report summarizing the 
new performance estimates and a “Delta” column that includes the 
impact your changes have had on the MOST RECENT values for task 
accuracy, time, and the probability of achieving the minimum 
acceptable accuracy. Each time you press “Apply,” the performance 
estimates will be a combined calculation based on all PTS settings so 
far, and the Delta values will show the amount of change from the 
immediately preceding “Apply” button click. If you wish to “Unapply” 
your choices, you must go back to the combo boxes where the settings 
were changed, adjust them so that they are in the N/A or 0 levels, and 
“Apply” these values again.

Note:
If you click Apply and do not see any adjustments, it may be that you have not 
assigned any taxons to your tasks.

Note:
In an Operations Model, only those tasks whose distribution types require 
mean time and standard deviation as parameters support the ability to apply 
PTS calculations.

Note:
To have the PTS-adjusted task times and accuracies take effect during your 
model run, you must check the PTS Adjustments check box on the Execution 
Settings dialog before running your model.

Execution Menu

Once you have created a mission and defined mission parameters, you are 
ready to check your model for errors. The Execution menu includes the 
Check for Errors option which scans the model for incorrect syntax and 
reports errors in the Output window. This option may be used prior to 
running your model or for debugging your model once it has run.

The Execution Menu also contains several options to control model 
execution. Options include Begin Simulation, Pause Simulation, Step 
Simulation, Halt Simulation, and Abort Simulation. You may also change 
the speed of model execution using the Simulation Speed option.
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Through an additional Settings option you can choose to apply PTS 
moderators, Perfect Accuracy, Workload Strategies and Cultural Modeling 
adjustments to the model and then specify the random number seed and 
number of runs for which the model should be executed.

The Execution menu has the following commands:

Check for Errors

Begin Simulation

Pause Simulation

Step Simulation

Halt Simulation

Abort Simulation

Simulation Speed

Settings

Check for Errors
The Check for Errors option should be use before executing a model and 
for debugging the model afterwards. For details, see “Checking for Syntax 
Errors” in IMPRINT Pro, Volume 2.

To check for syntax errors:

1. From the Execution menu, click Check for Errors. Alternatively, you 
may use the shortcut keys Ctrl+Shift+G.

Any detected errors display in the Output window.
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2. To open the dialog box where the error occurs, double-click the error.

IMPRINT Pro generally indicates the nature of the problem in the error 
message, such as “unrecognized word” for a misspelled or undeclared 
variable or function, or “semicolon expected at end” for a missing semi-
colon.

Common problems include typographical errors in an expression, 
omitting a semi-colon, forgetting to define a variable or using the wrong 
case for a variable name. Because IMPRINT Pro distinguishes between 
upper and lower case letters, name, NAME, and Name are considered 
to be different and unique variables.

A detailed description of commonly encountered errors and methods to 
correct them is available in the IMPRINT Pro User’s Guide, Volume III, 
Appendix: Checking for Errors.

Begin Simulation
To start or resume model execution:

From the Execution menu, click Begin Simulation. Alternatively, you 
may use the shortcut keys Ctrl+G.

The model executes (or resumes execution if previously paused).

Note:
Each time you run an operational mission or a maintenance scenario, your 
analysis automatically saves to the database just prior to the model run.

Pause Simulation
To pause model execution:

1. From the Execution menu, click Pause Simulation. Alternatively, you 
may use the shortcut keys Ctrl+P.

The model pauses executing.

2. When ready to resume model execution, click Begin Simulation on the 
Execution menu.
99



IMPRINT Pro Basic Procedures
Step Simulation
To step through model execution:

1. From the Execution menu, click Step Simulation. Alternatively, you 
may use shortcut keys Ctrl+T.

IMPRINT Pro executes the next event and then pauses.

2. Click Step Simulation again.

IMPRINT Pro executes the next event and then pauses.

3. To resume continuous execution, click Begin Simulation.

Note:
Each time you run an operational mission or a maintenance scenario, your 
analysis automatically saves to the database just prior to the model run. This 
includes initiating a model run using the Step Simulation command.

Halt Simulation
Use the Halt Simulation any time you wish to stop your model run. Halting 
the model allows any ongoing Beginning Effects, Ending Effects, timed 
Snapshots and/or External Events to complete before the model run stops, 
allowing the model to end gracefully. In the event your model encounters 
an infinite loop in any of these types of events and therefore cannot end, 
choose the Abort Simulation option from the menu instead to end your 
model run.

To stop model execution:

From the Execution menu, click Halt Simulation. Alternatively, you 
may use the shortcut keys Ctrl+H. 

The current execution stops. 

Note:
If you click Begin Simulation after you have halted an execution, a new run 
starts.
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Abort Simulation
The Abort Simulation option should be used to end a model run only in the 
event the Halt Simulation option does not work, such as in the case of an 
infinite loop.

To abort model execution:

From the Execution menu, click Abort Simulation. Alternatively, you 
may use the shortcut keys Ctrl+Shift+Y. 

The current execution aborts.

Simulation Speed
The Simulation Speed option controls the speed of real time mission 
simulation. 

To set a simulation speed:

1. From the Execution menu, click Simulation Speed.

A list of speeds appear.

2. Select a speed. Optional speeds include 25%, 50%, 100%, 200%, 
400%, or 800%; each execution speed is twice as fast as the speed 
listed above it.

Settings
The Settings option allows access to execution settings for Operational or 
Maintenance models.

To access model execution settings:

From the Executions menu click the Settings option.

A new dialog box appears in the main IMPRINT Pro window, displaying 
options for model execution.
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Edit Execution Settings
Before running an Operational Mission model or a Maintenance Scenario 
model, you may wish to edit the execution settings for the model run. 

Note:
Upon saving any mission or scenario, the current execution settings saved as 
part of it.

To edit execution settings:

1. From the Execution menu, click the Settings item.

The Execution Settings dialog box displays. 

The type of model currently loaded and selected in the Analysis tree 
(Operations, Maintenance or Force model) determines the type of 
settings to appear in this window. For example, if you currently have an 
operational mission selected in the Analysis tree, the Execution 
Settings window is automatically set to display the Operations Model 
execution settings. To view Maintenance Model execution settings, 
click the radio button beside the Maintenance Model option.

2. Edit the execution parameters.

Model execution parameters are described in the following section.
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Operations Model Parameters
The Operations model settings box contains the following editable 
execution parameters for the currently loaded mission listed in the top of 
the window:

Number of times to Run the mission. This number determines 
how many times the model must run each time a simulation run 
starts from the beginning. If the number is greater than one, the 
execution times, paths of execution, and other probabilistic 
events are likely to be different for each run. If you run the model 
multiple times with the PTS Adjustments, Perfect Accuracy, 
Workload Strategies and Cultural Modeling options enabled, the 
data from these options will also appear in the results files along 
with data from all consecutive runs.

Random Number Seed. The random number seed is the 
number used to generate random numbers for calculating task 
execution times and taking probabilistic paths through the 
network. The random number seed is a number between 
approximately -2 billion and +2 billion (inclusive). The same seed 
always produces the same set of random numbers in the same 
order, and thus the same results.

PTS Adjustments. You may select “PTS Adjustments” to use 
the adjusted times and accuracies that were the result of the 
combined applied Personnel Characteristics, Training 
Frequencies and Stressors on the Calculators→Performance 
Moderators menu.

Perfect Accuracy. Use this option to run the model with perfect 
accuracy (i.e., no task ever fails.) This method is sometimes 
useful when debugging your mission model.

Workload Strategies. Check the Workload Strategies check 
box to implement Workload parameters set on the Warfighter 
dialog.
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Animation On. Check the Animation On check box to view an 
animated representation of ongoing operator workload. In order 
to view the animation during your model run, you must first open 
the Animator window by selecting it from the View menu under 
the Windows submenu.

Note:
For best animation viewing results, enable the Display Trace option located 
on the Utilities menu before running your model. Viewing performance may 
also be improved by choosing a reduced Simulation Speed, available 
through the Execution menu and on the Tool bar.

Cultural Modeling. Check the Cultural Modeling check box and 
choose a Cultural template you created to apply pre-set 
conditions to your model that are known to be found in a 
particular cultural environment.

Maintenance Model Parameters
The Maintenance model settings box contains the following editable 
execution parameters for the currently loaded scenario listed in the top of 
the window:

Length of Run. Select the number of days over which to 
execute your model.
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Random number seed. Contains the number used to generate 
random numbers for calculating task execution times and taking 
probabilistic paths through the network. The random number 
seed is a number between approximately -2 billion and +2 billion 
(inclusive). The same seed always produces the same set of 
random numbers in the same order, and thus the same results.

Number of Systems. Select the number of systems to run. The 
number of systems defaults to one.

PTS Adjustments. Select “PTS Adjustments” to use the task 
times and accuracies that were adjusted as a result of the 
combined applied Personnel Characteristics, Training 
Frequencies and Stressors on the Calculators→Performance 
Moderators menu.

Crew Limits On. This check box lets you run the scenario in an 
unconstrained mode, regardless of the entries you make on the 
Maintenance Crew dialog. This means that IMPRINT Pro will 
ignore the shift manning on Equipment–Scenario–Maintenance 
Crew spreadsheet.

Animation On. This option enables the Animator window to 
display an animated version of a scenario and its corresponding 
maintenance data as it runs.

Note:
For best animation viewing results, enable the Display Trace option located 
on the Utilities menu before running your model. Viewing performance may 
also be improved by choosing a reduced Simulation Speed, available 
through the Execution menu and on the Tool bar.
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Force Model
The Force model settings box contains the following editable execution 
parameters for the currently loaded force unit listed in the top of the 
window:

Length of Run. Select the number of days over which to 
execute your model.

Random number seed. Contains the number used to generate 
random numbers for calculating task execution times and taking 
probabilistic paths through the network. The random number 
seed is a number between approximately -2 billion and +2 billion 
(inclusive). The same seed always produces the same set of 
random numbers in the same order, and thus the same results.
106



Chapter 5: IMPRINT Pro Menu Structure
Reports Menu

On completion of a model run, IMPRINT Pro can create reports pertaining 
to an Operations model, Maintenance Model, Force Model, Personnel 
Attributes and Cross-model Analysis. 

To review one or more of the reports:

1. Click the Reports menu.

A secondary menu will display from which you can select the type of 
report to be reviewed:
• Operations Results
• Maintenance Results
• Force Results
• Personnel Attributes
• Cross Analysis Report

 When you make this menu selection, you will be presented with an 
additional interface displaying all available reports for the type of report 
selected. 
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2. Select the report options you want.

3. Click OK. 

IMPRINT Pro creates a new Microsoft Excel workbook that contains a 
separate worksheet for each selected report and graph.

 A sample report workbook is shown in the following figure.

Each report can be accessed by clicking on its corresponding tab at the 
bottom of the workbook. Any selected report can be printed by selecting 
the “Print icon” in the Tool Bar.

Operational Results Reports
Several reports are available after an Operations Model (Mission) has 
completed.

To display operational results reports:

1. From the Reports menu, click Operational Results. 

A dialog box displays, showing all selectable reports.

Sample Report
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2. Check the reports you want to see, and then click the OK button. 

3. If the Specialty Usage report is selected or if the Check All button is 
pressed, the Assign Grade Levels dialog displays, prompting you to 
select grade levels (E1-E9) for each of the Operators in your model. 

For each listed operator, select a corresponding grade level from the 
drop-down list under the Grade column, and then click the OK button.

Operation Model Report Selection Dialog
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4. If the Workload Graph is checked, the Workload Over Time dialog 
box displays, prompting you for the range of time over which workload 
should be graphed.

Enter the desired Start Time and End Time for the range of data you 
wish to graph, and then click the OK button.

5. If the Operator Workload Detail report is checked, click the Group or 
Ungroup radio button to group or ungroup the data by simulation clock 
time.

Workload Graph Time Selection Dialog
110



Chapter 5: IMPRINT Pro Menu Structure
6. Click OK.

Excel launches, and all selected reports appear in an Excel workbook 
format.

Select the report you want to view by clicking the corresponding tab at 
the bottom of the workbook. For more information on Operational 
Results Reports see IMPRINT Pro User Guide Volume 2 - Developing 
Analyses, Chapter 4: Mission and Personnel Reports.

Maintenance Results Reports
To create maintenance model reports:

1. Select Maintenance Results from the Reports menu. 

When you make this menu selection, a new dialog box will appear, 
prompting you to first select the reports you wish to generate for that 
scenario.

2. Choose each report you wish to view by clicking its check box to the 
left.

3. Click OK.

Operation Model Reports
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The selected Maintenance reports display.

Select the report you want to view by clicking the corresponding tab at 
the bottom of the workbook. For more information on Maintenance 
Results Reports see IMPRINT Pro User Guide Volume 2 - Developing 
Analyses, Chapter 5: Maintenance Model Results Reports.

Force Model Reports
After running the force model for the desired force unit, you can view the 
results of your model run using the Reports option.

Maintenance Model Report Selection Dialog

Maintenance Model Reports
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To view force analysis reports:

1. From the Reports menu, select Force Model Results.

A dialog box appears, showing all available reports for your model run.

2. Select the check boxes of the reports you want to view, and then click 
the Ok button.

Microsoft Excel launches, and the reports you selected appear as separate 
sheets in a workbook. Click the tab at the bottom of the workbook 
corresponding to the report you want to view.

For more information on Maintenance Results Reports see IMPRINT Pro 
User Guide Volume 2 - Developing Analyses, Chapter 8: Viewing Force 
Analysis Reports.

Sample Force Report
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Personnel Forecast Report
For every operator in your analysis having a unique specialty, the 
Personnel Forecast Report displays the number of people of that specialty 
who will be available over the course of the next five years. Estimates are 
broken down by E-level (E3, E4...E9).

To create a Personnel Forecast Report:

1. From the Reports menu, click Personnel Forecast.

The Personnel Forecast report dialog box displays.

2. In the Personnel Forecast report dialog, check the boxes corresponding 
to the data you wish to view. Available options are:
• Personnel Forecast: this report displays forecast data for all unique 

specialties in your list of operators in a single report. For every year 
forecasted, the report breaks down the number of forecasted 
personnel for that specialty by E-level (E3, E4...E9). Data are 
presented in a tabular format.

• Personnel Forecast Graphs: for each unique specialty in your list of 
Operators, a new graph report is create, displaying that specialty’s 
forecast data in the form of a three-dimensional bar chart. For every 
year forecasted, the report breaks down the number of forecasted 
personnel for that specialty by E-level (E3, E4...E9).

3. Click OK.

Microsoft Excel launches, and the reports display.
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In the example below, the report is run for five different helicopter 
repairman specialties: 15M, 15R, 15S, 15T and 15U. The generated report 
displays estimates on how many personnel of each specialty category will 
be available through the year 2012.

Note:
In the example below, IMPRINT Pro omits the 15M specialty due to the 
unavailability of data for this specialty.

 

Personnel Forecast Report

The Personnel graphs display the same information in the form of a bar 
chart:
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Personnel Forecast Report

Cross Analysis Report
The Cross Analysis Report allows you to display the results of one or more 
missions (or scenarios) side-by-side and compare their summary data.

To run the Cross Analysis Report:

1. Run the missions in your models that you wish to compare.

2. From the Reports menu, select Cross Analysis Report.

A report selection dialog appears:
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3. If you wish to compare Mission runs, click the Operations Model radio 
button.

A list of all missions run in the current session of IMPRINT Pro appear.

4. Check the box for each mission you wish to include in your comparison.

5. Click OK.

Excel launches, and the Cross Analysis report appears.

Summary data for all selected missions displays.

Cross Analysis Report - Operations Model
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6. For comparison of equipment scenarios, click the Maintenance Model 
radio button.

7. Check the box for each scenario you wish to include in your 
comparison.

8. Click OK.

Excel launches, and the Cross Analysis report displays.

Cross Analysis Report Dialog - Maintenance Model
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Summary data for all selected scenarios display.

Disable Reports
The Disable Reports option allows you to run your model as normal, but it 
disables the post-processing step performed by IMPRINT afterwards. The 
post-processing step is required for compiling all data from the model run in 
a format which can be used and displayed by the reports. By choosing to 
disable this option, you may perform back to back runs of your model 
without having to wait for post-processing in between. You may not, 
however, view any report data until reports are once again enabled and the 
model is re-run.
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Tools Menu

The Tools menu includes the following features:

Accuracy Calculator

Micromodels

Syntax Helper

Unit Conversions

Accuracy Calculator
In IMPRINT Pro, the likelihood that a task will be performed accurately is 
determined by an estimated mean and standard deviation that work 
together with the accuracy measure (for example, “percent steps correct”). 
When the model runs, IMPRINT Pro pulls a number from a normal 
distribution created with the mean and standard deviation you enter. This is 
compared to the accuracy standard to determine whether the task 
succeeded or failed its accuracy on each occurrence. If the number pulled 
is higher than the accuracy standard and the accuracy measure 
determines that higher equates with more accurate (e.g., percent steps 
correct), then the task is considered a success.

For example, you might say that on the average when performing this task 
the operators get 90 percent of the steps correct, or for another tasks they 
are within 10 mils of the correct azimuth. Under the first option, you will also 
specify the standard deviation, which is a measure of the worst and best 
the task is likely to be performed. An easy rule of thumb for specifying the 
standard deviation is to compute the difference between the worst and best 
performance and divide it by 6. For example, if the worst performance is 
40% steps correct and the best is 100%, then an estimate for the standard 
deviation would be 10% (((100 - 40)/6) = 10).

We realize that it is often difficult for users to think of accuracy in these 
terms, and that it is often easier to think of it in terms of the probability of 
success. To accommodate this fact, we have provided a calculator that you 
can use to calculate the probability of success from the information you 
have entered. When you select the Accuracy Calculator, IMPRINT Pro 
uses your accuracy mean and accuracy standard deviation, as well as the 
accuracy standard to calculate the probability of success. This is actually 
120



Chapter 5: IMPRINT Pro Menu Structure
calculated using standard statistical procedures that compute the area 
under a Normal statistical curve. IMPRINT Pro is also careful to evaluate 
your accuracy measure to determine whether “bigger values” are better (for 
example, percent steps correct), or “smaller values” are better (for 
example, mils from desired). For more information, please refer to a 
statistics textbook.

We have also provided access the Accuracy Calculator dialog box that lets 
you enter three of the four data elements that are needed to specify 
accuracy (that is, accuracy standard, accuracy mean, accuracy standard 
deviation, and probability of success), and it will calculate and display the 
fourth data item. In addition, it will draw the normal distribution and show 
the area under the curve that is used to calculate the probability of 
success.

To use the Accuracy Calculator:

1. In the Network Diagram or the Analysis tree, select a task for which 
accuracy will be calculated.

Note:
By choosing a task first before opening the Accuracy Calculator window, the 
Accuracy Calculator window, once opened, will then automatically provide an 
option for applying your calculated value to this selected task.
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2. From the Tools menu click Accuracy Calculator.

The Accuracy Calculator window appears.

3. Choose a description of measure from the Measure drop-down list 
which best describes accuracy for your task.

4. Click the radio button of the value you wish to calculate. Values include 
Accuracy Requirement, Probability of Success, Mean Accuracy and 
Standard Deviation.

5. Enter values in the remaining three fields.

6. Click the Calculate button next to the choice you selected.

Your calculated value appears in the adjacent field.

7. Click the Apply to Selected Task button if you wish to replace your 
task’s existing value with the newly calculated value.

Micromodels
Select Micromodels to access to a set of micromodels of human 
performance that have been gathered from psychological research 
literature. Many of these micromodels are just constant values, for example 
the Eye Movement Time (target is in the field) micromodel which has an 
algorithm value of 0.1 which translates into a 2.00 second adjustment in the 
mean task time. Other micromodels include prompts for you to enter 
pertinent data, for example the Hand Movement micromodel which 
requires entering a distance to target and target size.
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To apply a Micromodel:

1. From the Tools menu click Micromodels.

The Micromodels window appears.

2. In the Micromodel Name field click the drop-down arrow to display a list 
of available micromodels. Click the desired micromodel to select it.

The micromodel name displays in the Micromodel Name field, and its 
algorithm and reference display in the fields below.
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3. Enter the necessary parameters in the P1 - P4 fields if required by the 
selected micromodel.

4. Click the Calculate button.

The Calculated Adjustment appears below.

5. Select the manner in which the adjustment should be applied to your 
current mean task time by clicking the radio button next to your choice. 
The Calculated Adjustment may be added to, subtracted from or 
replace the current mean task time. By default, the option None is 
selected. 

By clicking the radio button of your selection, the modified mean task 
time (as it would be if you applied this adjustment) appears in the 
Adjusted Mean Time field.

6. Click the Apply to Task button to replace the current mean task time 
with the Adjusted Mean Time 

Syntax Helper
The Syntax helper is an interactive tool that helps you see the acceptable 
syntax for any expressions you might enter in IMPRINT Pro. Use the 
syntax help if you are uncertain of the format of any expression. You can 
copy and paste the sample code from the helper into your beginning 
effects, ending effects or advanced mean time expressions and then 
modify the generic expressions to suit the needs of your model. Use the 
sample code for more guidance. 

A detailed description of syntax is available in the IMPRINT Pro User’s 
Guide, Volume III.

To use the Syntax Helper:

1. From the Tools menu click Syntax Helper.

The Syntax Helper window appears.

2. In the list on the left, click the desired code example under the Loops 
section or the Conditional Statements section. For example, click the 
“Do” listing to see sample code for a do-while expression.

Sample code appears in the window on the right. You may copy and 
paste code from this window into any code window in IMPRINT Pro.
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3. Replace all parts of your pasted code containing “<expression>” with 
code that achieves your goal.

Unit Conversions
The Unit Conversions tool is a calculator which converts a value in a 
particular unit of measure to its equivalent value in a different unit of 
measure.

To use the Unit Conversion tool:

1. From the Tools menu click Unit Conversions.

The Unit Conversions window appears.

2. Click the Time tab or Distance tab, depending on the type of units you 
wish to convert.

3. Enter the value to be converted in the Original Value field.

4. Select the desired “from” and “to” units by clicking the drop-down 
arrows in each field and selecting the desired units from the lists 
provided.

The Result field automatically updates with the converted value.
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Utilities Menu

The Utilities menu has the following commands:

Display Trace

Network Animation

Update Comment Variable

Alignment

Enable Snap to Grid

Export Task Network To Excel

Display Trace
The Output window displays the actions that occur when you run the 
model. This output is called the trace data. The following information 
displays:

Clock values for beginning effects

Clock values for ending effects 

Clock values for scenario events 

Syntax errors
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Whether the plugins (such as Animator .dlls) are successfully 
loaded when IMPRINT Pro is started

When a run or simulation begins and ends

Application errors

To display trace data in the Output window:

From the Utilities menu, click Display Trace to enable this option. 

A check mark displays next to this option in the Utilities menu to 
indicate the option is enabled. 

The next time you run the model simulation, trace information displays 
in the Output window.
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To disable trace data in the Output window:

From the Utilities menu, click Display Trace to clear the check mark 
adjacent to this option.

The next time you run the model simulation, trace information does not 
display in the Output window. The only information that displays is the 
simulation clock value, run number and duration of simulation.

Note:
When you disable the display of trace data, you cannot enable network 
animation, charts, event queue, or comment variables to display.

To clear the Output window:

From the Edit menu, click Clear Output.

The Output window clears.
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Network Animation
When you execute an IMPRINT Pro mission model, you can view the 
model execution as it occurs using network animation. When you enable 
network animation, you can watch entities move through the network 
diagram. When an entity is in a task or function, the task or function 
highlights in blue as beginning effect of that task (or any subtask belonging 
to the function) is evaluated. The number of entities in a task or queue are 
indicated by numbers above that display above the task or queue. 
Disabling network animation speeds model execution.

Note:
You must enable the display of trace data before you can enable the display of 
network animation.

To enable the display of network animation:

From the Utilities menu, click Network Animation.

A check mark displays next to this option in the Utilities menu to 
indicate the option is enabled. 

The next time you run the model simulation, network animation displays 
in the Task Network window.
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To disable the display of network animation:

From the Utilities menu, click Network Animation so that the check 
mark adjacent to the label Network Animation clears.

The next time you run the model simulation, network animation does 
not display in the Task Network window.

Update Comment Variable
You can select variables to display on the task network diagram during 
model execution in Comment boxes. Once you add a comment box and 
select the variables for display, you can enable or disable the update of 
these variables during model execution. To maximize execution speed, 
disable the update of Comment variables to display.

To update Comment variables during model execution:

From the Utilities menu, click Update Comment Variables.

A check mark displays next to this option in the Utilities menu to 
indicate the option is enabled.

The next time you run the model simulation, any variables selected for 
display in Comments dynamically update as the model executes.
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To disable the update of Comment variables during model execution: 

From the Utilities menu, click Update Comment Variables so that the 
check mark adjacent to the label Update Comment Variables clears.

The next time you run the model simulation, any variables selected for 
display in Comments do not update.

Alignment
You can align network objects with one another along a vertical line or 
along a horizontal line. You can also center objects vertically or 
horizontally. IMPRINT Pro aligns the objects with the leftmost, rightmost, 
highest, or lowest object.

To align network objects:

1. Using your left mouse button, select the objects to align by dragging a 
box around them. Alternatively, you can press the Shift or Ctrl key and 
click the items with the mouse.

The selected items appear highlighted in blue.

2. From the Utilities menu, click Alignment.

3. Select one of the following:
• To align the left sides, click Align Left. Objects are aligned with the 

leftmost object.
• To align the right sides, click Align Right. Objects are aligned with 

the rightmost object.
• To align the tops, click Align Top. Objects are aligned with the 

highest object.
• To align the bottoms, click Align Bottom. Objects are aligned with 

the lowest object.
• To align the objects on the same horizontal line, click Center 

Horizontally. Objects are aligned on a horizontal line that is midpoint 
between the highest and lowest object.

• To align the objects on the same vertical line, click Center 
Vertically. Objects are aligned on a vertical line that is midpoint 
between the leftmost and rightmost object.
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Enable Snap to Grid
The Snap to Grid option allows objects in the network diagram to snap to 
the invisible grid as they are moved. By using the grid, tasks and functions 
align easily as you move them in your network diagram thus keeping the 
network diagram appearance more orderly.

To enable snap to grid:

From the Utilities menu, click Enable Snap to Grid.

The Snap to Grid feature is enabled, and a check mark displays 
adjacent to the Snap to Grid option in the Utilities menu. Objects on the 
network diagram snap to the invisible grid as they are moved.

To disable snap to grid:

From the Utilities menu, click Enable Snap to Grid.

The Snap to Grid feature is disabled, and the check mark adjacent to 
Snap to Grid item is removed. As you move objects on the network 
diagram, they move in a continuous line.

Export Task Network To Excel
The Export Task Network to Excel option exports all task network 
information from the selected mission to an Excel report which may be 
shared and understood by non-IMPRINT users. The report displays a 
listing of all network nodes in your selected mission model and includes 
information on how they connect to the other nodes in the network. 
Exported items include tasks, functions and goals.

To export the task network to Excel:

1. From the Utilities menu, click Export Network to Excel.

A Save As dialog appears.

2. Using the drop-down option next to the Save In field, navigate to the 
folder in which you wish to save your exported data.

3. In the File Name field, type in the desired name of your exported data 
file.
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4. Click the Save button.

All task network data exports to an Excel report. 

To view exported task network data

1. Browse to the location of the exported network task data file on your 
system.

2. Double-click the file.

Excel launches, and the task network data report displays.
 

For each node listed in the report, the following information displays:

Object Type. The type of object in the network diagram. Types 
include: NetworkTask, NetworkFunction, NetworkGoal, 
StartTask and EndTask.

ID. The IMPRINT ID of the listed object. The ID displays as either 
“Root” for any object added to the root level of the network or as 
a string value indicating its placement within the subnetwork of 
another function or goal in the network. For more information on 
IMPRINT object identification, see “Network Object 
Identification” in Volume 2: Developing Analyses. 
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Parent. The IMPRINT ID of the listed node’s parent object. The 
ID displays as either “Root” for any object added to the root level 
of the network or as a string value indicating its placement within 
the subnetwork of another function or goal in the network. For 
more information on IMPRINT object identification, see “Network 
Object Identification” in Volume 2: Developing Analyses. 

Name. The listed object’s name.

Paths. The IMPRINT IDs of all other nodes to which this node 
connects in the network.

Decision Type. The decision type set in the listed node’s path 
type field. Path types include Single, Multiple, Tactical and 
Probabilistic.

Help Menu

The Help menu has the following commands:

Help

About

Help
The Help command launches an electronic copy of the IMPRINT Pro User 
Manual. You may browse the available help topics or search by key words 
to locate a specific help topic.

To open online help:

From the Help menu, click Help. 

A new window displaying the contents of the IMPRINT Pro user manual 
appears. This window contains the following three tabs:

Contents. Navigate the listed topics by expanding the 
categories on the left side of the window. Single-click any topic in 
this list to display its contents in the right side of the window.
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Index. Type a keyword or letter to bring up all Index listings 
starting with that word or letter. Click the topic in the listings 
below which most closely matches the topic of interest to display 
its contents in the right side of the window.

Search. Type a keyword or letter in the search field, and then 
click the List Topics button to bring up a list of topics starting 
with the keyword or letter you entered. Click the topic in the 
listings below which most closely matches the topic of interest to 
display its contents in the right side of the window.

About
The About command displays version information for your installation of 
IMPRINT Pro. This information may be helpful in tracking down any issues 
or “bugs” in this version.

To display version information:

From the Help menu, click About.

A window containing version information appears.
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A

Accuracy Measure
Accuracy Measure is a unit corresponding to the nature of how your task’s 
accuracy is measured. This unit helps IMPRINT Pro to determine whether 
your task is more or less accurate when the number pulled from the 
accuracy distribution is greater or less than the requirement you set. For 
example, assume that your Accuracy Measure is set to Percent Steps 
Correct and your Accuracy Requirement is set to 80. If the number pulled 
from the Accuracy distribution is 85, then IMPRINT Pro will consider this 
accuracy value to be a success since 85% is better than 80% in the context 
of Percentage of Steps Correct. If, however, you intend choose the unit of 
Measure Feet from Desired, IMPRINT Pro will consider this accuracy value 
of 85 to be a failure since 85 is less accurate that 80 in the context of Feet 
from Desired.

Accuracy Requirement
The Accuracy Requirement is the minimum acceptable accuracy for a task 
in order for it to be considered a success. 

Accuracy Standard Deviation
The Accuracy Standard Deviation specifies how tightly all the various 
values in the distribution are clustered around the Mean Accuracy value.

Activities Trump Matrix
A matrix used to set task priority within a Force Unit schedule for when any 
two activities overlap.

Analysis Description
A brief description of the analysis found in the Properties window. The 
Analysis Description is optional. 

Analysis Name
The Analysis Name can be 20 characters long and can include spaces and 
symbols. When an analysis is added, IMPRINT Pro automatically 
generates an analysis name that the user may edit in the Properties 
window. However, when an analysis is saved, the user will need to enter a 
name in the dialog provided.
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Analysis Version
The Analysis Version can be 20 characters long and can include spaces 
and symbols. When an analysis is added, IMPRINT Pro automatically 
generates an analysis version that the user may edit in the Properties 
window. When an analysis is saved, the user will need to enter a version 
number in the dialog provided.

Array
An ordered set of variable values that are indexed to a single variable 
name. An array can be a one-dimensional list, a two-dimensional table of 
rows and columns, or a multi-dimensional array.

B

Beginning Effect
An expression used to change the values of variables in the model as a 
result of a task starting.

C

Clock
System variable that records elapsed time in simulation time units since the 
beginning of model execution. The Clock variable can be used in any 
expression in a model.

Contingency Operators
One or more contingency operators may be selected for each task. During 
the task reallocation process, a contingency operators will be considered if 
workload overload occurs during mission execution.

Crew Ratio
Crew Ratio is the average number of crews available for each new system 
in the unit. In some cases where systems are required to operate 
continuously there may be multiple crews for each system.

Criterion
This value is the percentage of time that this task, function or mission must 
meet both its time requirement and its accuracy requirement 
simultaneously in order to be considered successful.
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D

Decision Node
A diamond-shaped object on a network diagram containing one of the 
following letters: P, M, or T—representing a Probabilistic, Multiple, or 
Tactical decision.

Decision Type
The Decision Type determines which path(s) an entity may follow when 
exiting a node which branches out along multiple paths. Tasks with a 
decision type of Multiple will follow all paths every time; tasks with a 
decision type of Probabilistic are likely to follow the path(s) in proportion to 
the percentages you set for each path; tasks with a decision type of 
Tactical will follow only those paths whose conditions evaluate to True; 
tasks with a decision type of Single will only ever follow one path. 

Distribution
The range of all possible values which can be assigned to a task’s time 
value and the probability that those values will be chosen at random.

E

Effect
An expression that executes as a result of task activity during model 
execution. Tasks can have beginning, and ending effects. You can use 
these effects to change variable values and thus represent the system 
changes that occur as a result of the task activity.

Ending Effect
An expression used to change the values of variables in the model 
because of a task ending.

Entity
A conceptual object that travels through a task network and indicates by its 
location when each task is executing or waiting to execute. The entity may 
represent a physical object, such as a part being built on a production line. 
It may also represent a person performing the tasks. Or, the entity may 
simply trace the sequence of tasks and not correspond to anything 
physical. During model execution, entities can be represented by symbols 
or numbers that travel through the network diagram. Entities are identified 
by corresponding values of their entity attributes.
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Entity.Duration
An Entity attribute that records the time each entity spends in the current 
task.

Entity.Tag
An Entity attribute that records the identity of each entity when there are 
multiple entities traveling through a network. Once an entity has an 
Entity.Tag value, the value stays with the entity through the remainder of 
model execution.

Estimated Task Accuracy
Use Task Mean Accuracy and Accuracy Standard Deviation under this 
section of the TimeAcc tab to specify an average value for how accurately 
a particular task is likely to be performed. For example, you might say that 
on the average when performing this task the operators get 90 percent of 
the steps correct or for another tasks they are within 10 mils of the correct 
azimuth. Under the first option, you will also specify the standard deviation, 
which in some sense is a measure of the worst and best the task is likely to 
be performed. An easy rule of thumb for specifying the standard deviation 
is to compute the difference between the worst and best performance and 
divide it by 6. For example, if the worst performance is 40% steps correct 
and the best is 100%, then an estimate for the standard deviation would be 
10% (((100 - 40)/6) = 10). Under this option you will define what is 
acceptable performance by specifying an accuracy standard. For example, 
you may say that any error greater 5 mils causes firing inaccuracies that 
are unacceptable. With the information above, the model then computes 
the probability of the task performance being at or above the standard and 
compares a selected random number to determine if task was performed 
accurately.

Estimated Task Time
The Estimated Task Time is the amount of time a task will take to execute 
as calculated by IMPRINT Pro. This time will vary each time the task is 
executed. To calculate this time, IMPRINT Pro starts with an initial task 
time which can either be represented as a value (entered in the Value field 
in the format of HH:MM:SS.mm) or as a time expression (entered in the 
Expression field and evaluated to seconds). Next, IMPRINT Pro pairs this 
initial time with a statistical distribution type. This distribution determines 
the possible values your task time could take relative to your initial value. 
When IMPRINT Pro runs, a random number is generated and is used to 
pull a number from the distribution you have specified. This number 
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becomes the Estimated Task Time for that occurrence of the task. Note: of 
the available 20 distribution types, IMPRINT Pro uses, by default, the 
Normal distribution which uses Mean and Standard Deviation to predict a 
task performance time. Depending on the distribution type you choose to 
use, different and/or additional parameters such as Shape, Probability of 
Success, Maximum, Minimum and Scale, might also be required. 

Event
Something that is scheduled to happen during a simulation at a specific 
clock time. Some events are expressions that you schedule to occur at 
specific times—these are called scenario events. All other events are 
scheduled, such as the finish times for currently executing tasks, as the 
model is running. You can watch events being scheduled by displaying the 
Event Queue window.

Event Queue
Events that are scheduled to happen during model execution are placed in 
an Event Queue. As each event occurs, it is removed from the top of the 
queue. These events are displayed in the Event Queue window.

Expression
A calculation, formula, macro, or statement that supplies a value or 
performs an operation. Expressions can contain combinations of numerical 
values (constants or variables), macros, mathematical and logical 
operators, and logical statements.

F

Force Unit
A Force Unit is a group of individuals, defined by jobs, who perform a 
variety of activities according to schedules.

Function
A network that is inside another network. In a model, all networks are 
functions except for the top network (level 1). You can create a function by 
dragging a function object to the Network Diagram from the Palette. Select 
the function with the pointer to open its diagram. Function diagram are 
drawn in the same way as the main network diagram. Functions usually 
also contains tasks.
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Function Criterion
Function Criterion is a percentage that determines how often the function 
must meet its Function Time Requirement to be considered a success. 
Enter a value between 0 and 100, inclusive.

Function Time Requirement
The Time Requirement is the slowest performance time that can be 
tolerated and have the function still be considered a success. When 
IMPRINT Pro executes your mission model, the performance time that is 
predicted by the aggregation of all tasks in this function will be compared to 
this standard to ensure that your design can meet the function level time 
requirement. The format for this entry (as with all other time values) is 
HH:MM:SS.mm. To enter a time requirement of 30 minutes, 15 seconds 
enter 00:30:15.00. Notice that you can enter hundredths of a second after 
the decimal point.

G

H

I

J

Job
The occupation held by one or more members of the Force Unit. Each job 
is defined by a name, specialty, rank and role. Examples may include Tank 
Driver, Navigator and Analyst.

K

L

Length of run
The number of days of operations that the IMPRINT Pro maintenance 
model will simulate. If you define mission segments for more days than are 
entered here, the model will not execute any segments that go beyond this 
value. This value defaults to 1.00.
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M

Macro
One or more mathematical or logical expressions that are assigned a 
single name and return a single value. When a macro name is encountered 
in an expression in a model, the model executes the expressions included 
in the macro and returns a value. IMPRINT Pro contains model, 
mathematical, and distribution macros for your use, or you can define and 
save your own macros with the model.

Maximum Number of Systems
This value is the maximum number of systems that would be assigned to 
your segment if available.

Mean Accuracy
The Mean Accuracy is the estimate of the most likely, or average, accuracy 
value for a task.

Mean Time Expression
The Mean Time represents the average number of seconds required to 
execute a task. You can either enter a mean time value (00:00:30) or you 
can enter an expressionclock<=30 then 10 else 15). Each expression is 
delimited by semicolons. In building the expression you can use any of the 
algebraic or logical operators including the following: (&, |, >, <, :=,==, +, -
,*, and /), and you can use if-then-else statements. The assignment 
operator is :=. The equivalence operator is ==. 

Minimum Number of Systems
This value is the minimum number of systems that must be ready to begin 
the segment prior to the cancellation time in order to prevent all departure 
groups from being canceled.

Mission Accuracy Criterion
The Mission Accuracy Criterion is a percentage that determines how often 
the mission must complete without abort to be considered a success. 
Aborts are caused when a task fails and the consequence of failure is 
mission abort Values can range from 0 to 100.

Mission Criterion
The Mission Criterion is the percentage that represents how often the 
mission must meet both its time and accuracy standards at the same time. 
Values can range from 0 to 100.
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Mission Description
The Mission Description is a fairly long text field that you can use to 
describe the mission you intend to model. The description is limited to 255 
characters. All printable text characters are allowed.

Mission Name
The Mission Name is a brief text label that you will use to uniquely identify 
your system’s mission. The mission name is limited to 60 characters. All 
printable text characters are allowed, including spaces.

Mission Time Criterion
The Mission Time Criterion is a percentage that determines how often the 
mission must meet its Mission Time Requirement to be considered a 
success. Values can range from 0 to 100.

Mission Time Requirement
The Time Requirement is the slowest performance time that can be 
tolerated and have the mission still be considered a success. When 
IMPRINT Pro executes your mission model, the performance time that is 
predicted by aggregating your individual tasks will be compared to this 
standard to ensure that your design can meet the mission level time 
standard. The format for this entry (as with all other time values) is 
HH:MM:SS.mm. So, to enter a time requirement of 30 minutes, 15 seconds 
enter 00:30:15.00. Notice that you can enter hundredths of a second after 
the decimal point.

MMH/System
Annual MMHs/system (ORG, DS, & GS levels) are the total number of 
annual maintenance manhour (by maintenance level) required to maintain 
one new system in that unit.

N

New Systems
This is the number of new systems that will be fielded in the unit.

Network
A sequential relationship of jobs (tasks and functions) that simulate a 
system, activity, or process. You create the network by drawing a network 
diagram, and you use variables to simulate the effects of the tasks on other 
tasks and on the system.
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Network Diagram
A graphical depiction of a model network showing the sequence of tasks 
and functions, and the possible paths through the network. You draw the 
network diagram using the objects on the Palette.

Number of times to run the mission
If you would like to run a model more than once, you can enter that number 
in this field. If you have a relatively short scenario (in days), you may want 
to run the model several times in order to be confident that the data you get 
from all of the runs is representative. One short run may, by chance, 
produce data that are not very typical. Running a model for a long period of 
time (for example, 90 days) will also improve the probability that the results 
are typical. IMPRINT Pro will automatically begin each run with a new 
random number seed. This value defaults to 1.

Number Per Departure Group
This value controls the number of systems per group (sometimes referred 
to as a “flag”) that are sent out on this segment.

O

OP Tempo
Annual OP Tempo is the usage per year that the new system is expected 
to accrue in the type and size unit listed.

Overall Workload
The sum of all single task demand values and all conflict values (inter-
channel and intra-channel) of all ongoing tasks that an operator is currently 
performing at a given instant of time (see Operator Workload Summary 
and Detail reports.)

P

Path
A sequential connection between two nodes (tasks or functions), drawn by 
dragging the mouse cursor from one node (source) to another 
(destination). The conditions under which the path is taken is specified in 
the Paths tab of the source node.
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Planned Activity
A planned activity is an activity comprising part of a Force Unit schedule, 
which has a designated start time and will last until the next scheduled 
activity is set to occur. Examples may include “guard duty,”” hygiene,” 
“eating” and “sleeping.”

Primary Operator
The Primary Operator is the Specialty and crew position that will be 
assigned to perform the task. 

Probability of Success
The Probability of Success is the likelihood that a task will succeed each 
time it is executed. This number can either be manually entered or can be 
calculated as a result of entering values for the remaining three fields upon 
which it is dependent, namely the Mean Accuracy, Accuracy Standard 
Deviation and the Accuracy Requirement.

Q

R

Random Number Seed
A number between approximately -2 billion and +2 billion used to generate 
random numbers for calculating task execution times and taking 
probabilistic paths through the network. You supply the random number 
seed when you define the Execution settings for a model.

Rank
An official position or standing in the armed forces. This information is used 
to help define the jobs in a force unit. Ranks include E1-E3 (Private and 
Private First Class), E4 (Specialist or Corporal), E5 (Sergeant), E6 (Staff 
Sergeant), E7 (Sergeant First Class), and E8-E9 (Master Sergeant, First 
Sergeant, Sergeant Major, Command Sergeant Major and Sergeant Major 
of the Army).

Release Condition
An expression that is evaluated to determine whether or not a task can 
execute. A task can execute only when the value of the release condition is 
nonzero or true. You supply the release condition when you define the 
task. The default release condition is always “true”.
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Repeating Segments
A Repeating Segment is one in which IMPRINT Pro’s maintenance model 
will attempt to send more systems out to perform this segment every so 
often. You can identify the frequency of the segment (for example, “repeats 
every four hours”).

Replacement Systems
The number of old systems that will be replaced in a unit.

Resource-Interface Channels
Resource-Interface Channels are formed by pairing the human resources 
with the interfaces (for example, visual/heads up display, motor/control 
stick). All workload is assigned to a task by setting individual single task 
demand values for each resource-interface channel used to perform that 
task.

Role
The level of participation that a job (an occupation held by one or more 
members of the Force Unit, such as a driver or gunner) will have in an 
unplanned activity if one requiring such a level occurs. Roles include 
Leader, Sub-Leader and Member.

Run number
The current run number in cases where there are multiple runs. The run 
number can be accessed through the expression Model.RunNumber.

S

Scenario Description
The scenario description is a free text field that you can use to document 
your analysis. It is limited to 255 characters.

Scenario Name
This is the name of your maintenance scenario. You can have many 
maintenance scenarios for each system.

Seed 
Random number seed used to run a model. The random number seed 
generates a set of random numbers that are used to calculate task 
execution times and probabilistic paths taken through the network. The 
random number seed can be set in the Execution dialog box. For multiple 
runs of a model, the variable Model.RandomSeed contains the random 
seed used to generate the particular run.
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Segment Cancellation Time 
This is the number of hours that the simulation will wait for the minimum 
number of systems to be available before canceling the segment. For 
example, if the minimum number of systems for this segment is six and 
there are only four available at the scheduled start of the segment then the 
segment must wait. If there is a value of “01:00:00.00” in this field, then if 
the minimum number of systems do not become available within one hour 
of the scheduled start, the segment will be canceled. The default value for 
this item is 00:00:00.00. This means that the minimum number of systems 
must be available at the start time of this segment in order for the segment 
to begin. Be very careful that your cancellation is not after the segment 
would be attempting to repeat.

Segment Duration Time
This value indicates the number of operational hours for this segment. This 
value is used to schedule the return of the systems from operations and the 
beginning of the maintenance window. Additionally, this time is used to 
determine usage for the equipment on which failures are triggered by time. 

Segment Priority
When more than one segment has been defined to occur at the same time, 
the segments must compete for available systems. In this box, you can 
enter a priority number for each segment. Available systems will be 
allocated to higher priority segments first.

Segment Repeat Mean Time 
If you have checked the Repeating box for your segment, you will be able 
to enter a time in the Segment Repeat Time box. The value in this box 
controls the frequency (in hours) with which the simulation will attempt to 
repeat this segment. If you will enter the number 4 in this box, it will indicate 
that you want this segment to repeat every four hours. In other words, this 
segment will try to start again every four hours throughout the simulation. If 
you wanted this segment to repeat only twice, you could do this by defining 
two separate but identical segments with one starting four hours after the 
first.

Segment Start Day
The Segment Start Day and the Segment Start time work together to 
identify the start time of this segment. This value defaults to 1. If you were 
to leave the default values in both of these boxes, this mission would begin 
at time 0 on day 1.
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Segment Start Time
The time entered in the Segment Start Time box indicates the time the 
segment is to begin. This value defaults to 00:00:00.00.

Shift Data
Enter the maintenance shift length in clock hours and the number of shifts 
per day. The product of the two numbers must be less than or equal to 24. 
The number of shifts will determine the number of shift columns in the 
Maintenance Crew spreadsheet

Shift Length
The length of shift in hours. 

Shifts per day
The number of shifts per day. 

Snapshot
An option that records the values of specified variables at particular points 
during model execution—for example, when a task starts or ends, at the 
end of a run, or at specific clock times. When you run a model for which 
you have defined snapshots, the values are recorded, and results may be 
viewed in the Snapshots report.

Specialty
Specialty is a designation for a particular military job within the Armed 
Forces referenced by a 3-letter designation. For example, a Scout 
helicopter repairer is designated 67S. This option enables you to select 
people of appropriate specialties for task assignments.

Spinner Task
A task with a path that goes back to itself. Spinner tasks are used to 
generate multiple entities to travel through the network.

Subsystem Equipment Group Name
The subsystem type indicates the operational units (Armament, Mobility, 
and Other) that are used to describe the usage for that subsystem
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Subsystem
A subsystem is one of several smaller elements comprising a system, for 
example, an engine is a subsystem that is part of a system called “Tank”. 
Each Subsystem is going to be one of three types (Armament, Mobility, 
and Other) and must be uniquely named. Subsystem type indicates the 
operational units that are used to accrue the usage for that subsystem 
Usage for an Armament subsystem is described as the number of rounds 
that have been fired from that subsystem. Usage for components in a 
Mobility system is described in terms of the distance that the system has 
traveled. Subsystems with a type of “Other” use operational time as the 
usage measure.

T

Task
Tasks are the basic building blocks of a model. A task is defined by timing 
information, execution constraints (or release conditions), effects of the 
task on the system, and routing information concerning following tasks and 
functions. Each time a task executes, the execution time is randomly 
calculated within the time distribution parameters you supply. You can 
create a task using the Palette and Network Diagram or through the 
Analysis Tree. To define a task simply double-click the task in the tree or in 
the network, and enter its information in the Task Properties window.

Task Accuracy Probability
As an alternative to specifying a task’s Accuracy Mean, Standard Deviation 
and Accuracy Standard data and relying upon IMPRINT Pro to calculate its 
Probability of Success, you can instead directly enter this value by (as a 
percentage) in the Probability of Success field. When the task runs, the 
value entered here is compared with a random number to determine if the 
task was performed accurately. 

Task Criterion
The percentage of time that the task must meet its time and accuracy 
standards in the same simulated occurrence in order to considered a 
success.

Task Mean Accuracy
The average value for how accurately a particular task is likely to be 
performed.
150



Glossary
Task Name
This text box displays the name of the task for which you are displaying or 
entering information.

Task Priority
On the Effects tab, task priorities are used to execute priority-based 
workload management strategies.The priorities range from 1 (very low) to 5 
(very high). New tasks are assigned a priority level of 3 (medium). To 
change a priority level for a task, double click on a task to open the task 
parameter window, click in the Task priority field of the task and enter a 
priority value between 1 and 5, or click on the drop box in the task priority 
field and select a priority from the list.

Task Standard Deviation
A measure that tells you how closely all the various task times calculated 
by IMPRINT Pro are clustered around the mean task time. In general, one 
standard deviation away from the task mean time in either direction 
(greater than or less than the mean) accounts for somewhere around 68 
percent of all computed task times. Two standard deviations away from the 
mean account for roughly 95 percent of the computed task times. And 
three standard deviations account for about 99 percent of the computed 
task times. By specifying the Task Standard Deviation for your task, you 
are helping IMPRINT Pro to determine how widely varied (or unvaried) the 
distribution of all your different calculated task times will be.

Task Time Requirement
The Time Requirement is the slowest performance time that can be 
tolerated and have the task still be considered a success. When 
IMPRINT Pro executes your mission model, the Distribution along with 
parameters Mean and Standard Deviation are used to choose a specific 
task time for each occurrence of each task. These times are then 
accumulated throughout the model run and compared to the time standard 
in order to report the percentage of successes for each task. To enter the 
time requirement, use the mouse to position the cursor in the time 
requirement box. 

Time Between Departures 
The value in the Time Between Departures field denotes the amount of 
time that must lapse between any two consecutive group departures for a 
given segment. This value is in hours and can be entered in the 
HH:MM:SS.mm format to include hundredths of hours.
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Time Format
Time data entered in the IMPRINT Pro interfaces or viewed in the IMPRINT 
Pro reports can be displayed in one of several different formats, such as 
hours, minutes, seconds and HH:MM:SS.mm. Time formats may be 
changed in the Time tab through the Preferences option under the View 
menu.

Time Requirement
The Time Requirement is the maximum acceptable performance time for a 
task.

U

Unplanned Activity
A unplanned activity is an activity which can interrupt the normal planned 
activities comprising a Force Unit schedule, Unplanned activities are 
defined by a probable start time, duration and the number of people 
required to address them. Examples may include “fire” and “emergency”.

V

Variable
An identifier which is used to represent a quantity which can vary in value. 
When a variable name is encountered in an expression, IMPRINT Pro 
substitutes in the current value of the variable and evaluates the 
expression. Variables are useful for representing changeable aspects of 
the system you are simulating. You can change the value of a variable 
through any expression in your model, for example, in a task effect or in a 
scenario event. For each IMPRINT Pro model, five system variables are 
automatically created including Clock, Distributions, Entity, Model, and 
Task. For more information about system variables see the “Variables” 
section in this manual.

W

Warfighter
A warfighter is any person or automated device that operates, maintains, 
supplies or supports military equipment.
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X

Y

Z
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Appendix A: Technical Description of 
Stressor Implementation

Evaluation of Human Performance under Diverse Conditions via Modeling 
Technology

Dr. Laurel Allender, Ms. Lucia Salvi, Dr. David Promisel

U.S. Army Research Laboratory Human Research and Engineering 
Directorate

Aberdeen Proving Ground, Maryland, U.S.A

Streamlined system acquisition and resource constraints are realities of 
military test and evaluation today. However, the pressure of saving time 
and dollars cannot be permitted to eliminate the assessment of total 
system performance - that is, the soldier, the hardware, and the software. 
Assessing combined soldier-system performance is as critical as ever. To 
address the challenges of the future battlefield requirements documents 
being written for military systems today regularly require operation in cold 
and hot conditions; in nuclear, biological, and chemical (NBC) 
environments; and over extended time periods. More and more functions 
are required to be automated, which does not necessarily make the job 
easier but, more likely, changes the nature of the job, the crew size, the 
task allocation, and the skills and abilities needed to do the job. These 
kinds of system requirements generate soldier-system dynamics that will 
affect overall system performance and must be evaluated throughout the 
system acquisition, design, and ultimately, the test and evaluation process.

In addition to the time and cost-effectiveness considerations that are 
givens for test and evaluation, regulations governing human use and test 
participant safety must also be considered. It is simply not permitted to test 
systems under all of the actual conditions in which they are required to 
operate. Certain hazardous conditions, for example, NBC operations, must 
be approximated. It is being proposed here that modeling not only provides 
a reasonable alternative for the approximation of performance under 
diverse--even extreme--conditions, but it also can be accomplished within 
the time and cost constraints. Existing data can be used to extrapolate to 
other conditions. Once a baseline model is built, excursions are typically 
straightforward. Modeling can be used iteratively to evaluate different 
conditions or to conduct sensitivity analyses and comparisons. 
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Over and above the ways in which modeling technology helps to address 
the time, cost, and safety concerns of test and evaluation, it offers a logical 
and sound approach to estimating human performance. It is a task-analytic 
approach that lends itself to good documentation and the building of audit 
trails. It can be used to help quantify what are, all too often, largely 
subjective assessments. It can also compensate for, or be used to extend 
operational field data that come with certain innate limits such as 
uncontrollable extraneous variables, small sample size, and non-
repeatability. Modeling too, has its limitations; however, in combination with 
more traditional test and evaluation methods, for example, in a model-test-
model mode, it can provide valuable estimates of human performance 
under a wide variety of conditions.

The IMPRINT Tool

The U.S. Army Research Laboratory Human Research and Engineering 
Directorate has developed a modeling and analysis tool, the Improved 
Performance Research Integration Tool (IMPRINT). The IMPRINT tool 
grew out of common U.S. Air Force, Navy, and Army manpower, 
personnel, and training (MPT) concerns identified in the mid-1970's: How 
to estimate MPT constraints and requirements early in system acquisition 
and how to enter those considerations into the design and decision-making 
process. The U.S. Navy first developed the HARDMAN (Hardware vs. 
Manpower) Comparability Methodology (HCM). The Army then tailored the 
manual HCM, which became known as HARDMAN I, for application to a 
broad range of weapon systems and later developed an automated 
version, HARDMAN II. In HARDMAN I and II, however, there was no direct 
link between MPT and performance. To directly remedy this shortcoming, 
the U.S. Army began the development of a set of software analysis 
modules in the mid-80’s (Kaplan, 1988). This set of modules was called 
HARDMAN III, and although the name was the same, it used a 
fundamentally different approach for addressing MPT concerns than 
previous methods. It provided an explicit link between MPT variables and 
soldier-system performance. IMPRINT, while being an improvement over 
HARDMAN III, for the purpose of the discussion here, is essentially 
HARDMAN III in the WindowsTM environment. 

The mechanism for the MPT-performance link is task network modeling 
provided by the commercially- available Micro Saint task network 
simulation modeling engine, PC software designed for describing and 
analyzing task networks. The modeling capability offered can be further 
characterized based on three distinctions (Law & Kelton, 1991): (1) static 
vs. dynamic, (2) deterministic vs. stochastic, and (3) continuous vs. 
discrete. A static model does not address system effects over time, 
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whereas a dynamic model represents a system as it changes with time. A 
deterministic model does not represent any probabilistic, or random, 
elements. A stochastic model does encompass random elements and 
produces output that contains random error. A discrete model refers to 
instances where the variables characterizing the system change 
instantaneously at separated points in time. A continuous model is the 
converse, with variables that change continuously with time. In some 
instances, systems can be treated as either discrete or continuous, 
depending on the objectives of the analysis. 

Using these definitions then, IMPRINT can be described as a dynamic, 
stochastic, discrete event modeling tool. When certain assumptions hold, 
namely, that the system of interest can be adequately described by task 
activities and networked sequencing, that dynamic processes and random 
variability are of interest, and that any continuous tasks can be fairly 
transformed into discrete tasks, then IMPRINT is an appropriate tool to use 
to represent and analyze soldier-system performance. 

The basic modeling capability in IMPRINT requires the decomposition of a 
system mission into functions which, in turn, are decomposed into tasks. 
The functions are linked together into a network describing the flow of 
events. The network can include various types of branching logic such as 
parallel branches, probabilistic branches, and repeating branches. Within 
each function, the tasks are sequenced using the same types of branching 
logic options. At the task level, estimates of task performance time and 
accuracy means and standard deviations are input along with the 
consequences of the failure to perform a task accurately enough. The 
failure consequence options are no effect, total mission abort, repetition of 
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that or some other task, or subsequent degradation of some other task. 
The data entered are assumed to be representative of performance under 
“typical” or baseline conditions. Also, standards of performance can be 
entered to provide benchmarks for performance adequacy at the mission, 
function, and task levels. A sample IMPRINT screen depicting a network of 
functions (containing tasks) is shown in Figure 1.

IMPRINT executes a mission model task-by-task by first drawing a task 
time from the distribution as defined by the mean and standard deviation 
input for each task. (IMPRINT assumes a default normal distribution 
although other distribution options are available). Then it calculates the 
probability of success for the task based on the accuracy inputs. Next it 
determines, for this instance, whether there is an accuracy failure. After 
checking for a given task, IMPRINT proceeds through the task and function 
networks in accord with the established branching logic and analyzes the 
output according to the standards. When the model execution is completed 
(which can be anywhere from 1 to 999 repetitions), reports of estimated 
performance at each of the three levels are generated along with the 
comparisons to the standards. Although any given model and its 
associated assumptions must be scrutinized, this approach is particularly 
useful for comparisons across systems or system conditions.

Sample IMPRINT Function and Task Network Windows
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Environmental Stressors in IMPRINT 

Along with the basic task network simulation modeling capability, the 
IMPRINT tool includes specific algorithms or look-up tables--environmental 
stressors--to assess performance under diverse conditions. Recall that the 
task performance data entered in the baseline model are assumed to 
represent performance under “typical” conditions. The embedded 
environmental stressors automatically adjust performance to account for 
the changes expected under different levels of the stressors. Currently, 
IMPRINT includes five environmental stressors: protective clothing (that is, 
Mission-Oriented Protective Posture or MOPP), heat, cold, noise, and 
hours since last sleep (see Figure 2). The application of a stressor will 
result in either less accurate task performance, longer times to complete 
the task, or both. Stressors may be applied to an individual task or to all the 
tasks assigned to a particular job or Military Occupational Specialty 
(Specialty) for the mission. When the model is re-run, the new, or 
“stressed,” task performance time and/or accuracy are used as the task 
estimates that are “rolled up” in the task, function, and mission reports and 
compared against the standards. Importantly, the results can also be 
compared with the baseline model predictions. (See Dynamics Research 
Corporation, & Micro Analysis & Design, 1993) for more complete 
documentation.)

 IMPRINT Window Showing the Environmental Stressor Options
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As a side note, IMPRINT also models the effects of two task performance 
shaping functions, based upon personnel characteristics and training 
frequency and recency. The personnel characteristics function uses both 
standardized Specialty entrance scores and the general Armed Forces 
Qualification Test (AFQT) scores. Different from the stressors, which only 
degrade performance, applying the performance shaping functions can 
result in either better or worse performance, depending on the level 
selected. For example, increasing the frequency of training results in 
improved performance, whereas decreasing the frequency lowers 
performance. IMPRINT also models the mental workload associated with 
task performance. Workload profiles can be developed for crew members, 
or, in the advanced mode, the interaction of workload and performance can 
be evaluated to include workload coping strategies and task-workload 
conflicts. Although these functions provide important analytic capabilities, 
the focus of the paper from this point is solely on the environmental 
stressors.

Before discussing each stressor in turn, it is important to note that not all 
tasks are affected in the same way or by the same stressor. To 
accommodate this, IMPRINT uses a task category weighting scheme. Nine 
categories or taxons used to describe a task (see Table A-1) (Fleishman & 
Quaintance, 1984). Category weights are assigned to each task so that the 
various stressor effects are likewise weighted. In this way, each task 
contributes only the appropriate amount of change to the “stressed” 
performance at the mission level. Every task can be categorized with as 
many as three taxons. For example, operating a tractor and semi-trailer 
may involve driving a vehicle that is classified as “fine motor continuous” 
and may involve giving or receiving instructions, which is classified as 
“communication (oral).” Additionally, weights, which must sum to 1.0, are 
used to describe the degree to which a particular task manifests a 
particular taxon. In the example cited, operating a tractor and semi-trailer 
task might be composed of .75 fine motor continuous and .25 
communication (oral). Modification of the taxon weights also allows for the 
consideration of new technology. For example, an automatic reloading 
device could change a heavy lifting or gross motor heavy task to a fine 
motor discrete task where only the manipulation of controls is required. 
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Table A-1: IMPRINT Taxons, Descriptions, and Task Examples

Taxons Definitions Examples

Visual Requires using the 
eyes to identify or 
separate targets or 
objects

Seeing something move 
and then recognizing it as 
an enemy tank

Numerical Requires performing 
arithmetical or 
mathematical 
calculations

Measuring an azimuth on a 
map with a protractor 

Estimating the distance 
between two points on a 
map

Cognitive 
(Problem 
Solving and 
Decision 
Making)

Requires processing 
information mentally 
and reaching a 
conclusion

Locating a fault in an 
electrical system after 
troubleshooting 

Selecting the best firing 
position for a machine gun

Fine Motor 
Discrete

Requires performing a 
set of distinct actions in 
a predetermined 
sequence mainly 
involving movement of 
the hands, arms, or 
feet with little physical 
effort

Assembly and 
disassembly of the M-16 
rifle 

Starting the engine of a 
truck

Fine Motor 
Continuous

Requires uninterrupted 
performance of an 
action needed to keep 
a system on a desired 
path or in a specific 
location

Driving a vehicle 

Tracking a moving target

Gross Motor 
Heavy

Requires expending 
extensive physical 
effort or exertion to 
perform an action

Lifting an artillery round 

Loosening a very tight bolt 
with a wrench
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Table A-2 details which task taxons are affected by which stressors in the 
current IMPRINT software. It also shows whether the task performance is 
degraded by time, accuracy, or both. Since degradation factors are 
processed as multipliers, the degradation factors affecting time will be 
greater than 1.0 to increase the performance time. On the other hand, the 
degradation factors affecting accuracy will be less than 1.0 to decrease the 
performance accuracy from the pre-existing accuracy level. The overall 
degradation resulting from a specified stressor is directly proportional to the 
weighting assigned to the affected taxon(s) comprising the task. 

Gross Motor 
Light

Requires moving the 
entire body (that is, not 
just the hands) to 
perform an action 
without expending 
extensive physical 
effort

Getting into a prone firing 
position 

Evacuating a tank

Communication 
(Read and 
Write)

Requires either 
reading text or 
numbers that are 
written somewhere or 
writing text or numbers 
that can be read

Reading a preventive 
maintenance check list for 
a vehicle 

Writing a letter home

Communication 
(Oral)

Requires either talking 
or listening to another 
person

Giving a situation report by 
radio 

Receiving a password from 
someone while on guard 
duty

Table A-2: Listing of the IMPRINT Environmental Stressors and the Taxon 
Types Affected by Either Time or Accuracy or Both 

Taxon MOPP Heat Cold Noise Sleepless 
Hours

Visual  T  A  T

Numerical  A TA

Cognitive  A TA

Table A-1: IMPRINT Taxons, Descriptions, and Task Examples (Cont.)

Taxons Definitions Examples
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where T = Affects task time only

A = Affects task accuracy only

TA= Affects task time and accuracy

Effect of MOPP
The effect of MOPP gear on task performance is modeled as a function of 
levels of MOPP gear and task taxon. As shown in the Table A-2, MOPP 
affects the time that it takes to complete tasks described by the visual, fine 
motor discrete, gross motor light, and communication (oral) taxons. The 
degradation factors were derived from a series of studies conducted by the 
former Ballistic Research Laboratory (Wick, 1988) where the measure of 
performance degradation for each task was the time difference between 
performing the task in Battle Dress Uniform (BDU) and performing it in 
MOPP 4. Each task was later described in terms of ten human ability 
codes. These codes were mapped to the IMPRINT taxons and the 
degradation factor for each taxon was computed as the average of the 
mapped degradation factors by human ability code. MOPP level 0 is 
equivalent to BDU and therefore has a degradation factor of 1 that 

Fine Motor 
Discrete

 T  A  T

Fine Motor 
Continuous

Gross Motor Light  T  T

Gross Motor 
Heavy

Communication 
(Read & Write)

 A

Communication 
(Oral)

 T  A  A

Table A-2: Listing of the IMPRINT Environmental Stressors and the Taxon 
Types Affected by Either Time or Accuracy or Both 

Taxon MOPP Heat Cold Noise Sleepless 
Hours
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correlates to “no degradation.” Degradation factors are applied as 
multipliers against the time that it takes to complete a task in BDUs. The 
most degraded performance is under MOPP 4 for fine motor discrete tasks 
and for oral communication tasks that take 1.7 times as long to perform. 
(The entire set of matrices of degradation factors for the stressors is not 
provided here but is available from the author on request.) 

Effect of Heat
 IMPRINT models the effects of heat on task performance accuracy as a 
function of dry bulb temperature and relative humidity using degradation 
factors based on various published reports and documents. Research 
relating heat stress to inaccurate performance (for example, Ramsey & 
Morrissey, 1978) was referenced. The MIL-HDBK-759-A (1981) was used 
to determine the effective temperature for different combinations of dry 
bulb temperature and relative humidity. And, data on the average number 
of mistakes per manhour as a function of effective temperature from the 
Bioastronautics Data Book (1981) were included in the derivation of the 
heat degradation factors. The derived factors applied solely to sedentary 
type tasks. Thus, the taxons affected are visual, numerical, cognitive, fine 
motor discrete, communication (read and write), and communication (oral). 
No degradation in accuracy performance is seen until the temperature 
reaches approximately 113o F (or 45o C) and the humidity reaches 
approximately 50%. Performance falls to essentially zero when the 
temperature reaches approximately 130o F (or 55o C) and the humidity 
reaches approximately 80%. 

Effect of Cold
Cold weather degradation factors affecting task time performance are 
modeled in IMPRINT as a function of ambient temperature and wind 
velocity. Two functional relationships were developed from a study 
(Teichner, 1958) that related wind chill to percentage of performance loss. 
One relationship was developed for visual reaction time, thus providing the 
data for the visual and fine motor discrete taxons; the other was developed 
for manual skills, providing the data for the gross motor light taxon. The 
degradation factors for cold are computed as the percent loss of 
performance as a function of wind chill, wind chill being a function of wind 
velocity and ambient temperature. Time effects range from a minimum of 
1.03 times as long for temperatures of approximately 35o F (or 1o C) and a 
wind velocity of approximately 10 knots to a maximum of 1.70 times as 
long for temperatures of approximately -40o F (or -40o C) and a wind 
velocity of greater than 50 knots. Note that this degradation does not 
account for prolonged exposure to cold and wind.
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Effect of Noise 
The way in which IMPRINT models the effect of noise on task performance 
is based on the effectiveness of voice communications as a function of 
noise level and distance between the speaker and the listener. As shown in 
the Table A-2, the degradation that results from various noise levels affects 
the accuracy with which a task that requires oral communications between 
two or more people is performed. The effect of noise on task accuracy and 
the resultant degradation factors were derived from a graph in MIL-STD-
1472C. Distances modeled range from 1 to greater than 20 feet and noise 
levels range from 50 to greater than 110 dB PSIL. Approximately midway 
through the ranges modeled, accuracy of performance essentially drops to 
zero, as might be expected.

Effect of Sleepless Hours
In IMPRINT, sleepless hours refers to extended operations or the lack of 
sleep. It is important to note that sleep deprivation is the only 
environmental stressor that causes degradation in both the time to perform 
a task and the accuracy with which it is performed. IMPRINT models the 
stress of continuous operations as a function of hours since last sleep. 
Ranges of hours since last sleep go from 24 hours to greater than 96. At 
the 96-hour range, time to perform tasks is essentially doubled and 
accuracy has dropped to zero. The factors included in IMPRINT were 
derived from a review of several studies (Belenky et al., 1987), which found 
that the only taxons that are affected by lack of sleep are numerical and 
cognitive. Of note, in contrast to cognitive performance, physical strength 
and endurance are relatively unaffected by lack of sleep and can be 
restored by simple rest.

Multiple Taxons with Multiple Stressors
Many combinations of multiple stressors and taxons are also implemented 
in IMPRINT. Table A-3 shows the possible combinations of stressors and 
the associated taxons. When two or more different stressors affect a task’s 
taxon in time or accuracy, the overall degradation is not just the sum of the 
individual degradations. In fact, the overall degradation is less than the 
sum of the individual degradations. As more stressors are added, they 
have less than the full effect on performance. Normally, the most severe 
stressor will have a full effect on performance. As additional stressors are 
added, they will have less and less impact on performance accuracy and 
time. This phenomenon is approximated with a power function (Harris 
1985).
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IMPRINT Verification, Validation, and Accreditation 
(VV&A)

HARDMAN III, the IMPRINT predecessor was subjected to a formal VV&A 
process, the first of its type in the U.S. Army. The first phase, which is 
applicable here, comprised the core task network modeling capability and 
the effects implemented as additions to or modifications of the task data--
mental workload estimation and environmental degradation, personnel 
characteristics, and training. A review board of representative users, 
policy-makers, technical experts, and soldier proponents evaluated the 

Table A-3: Possible Combinations of Stressors and Taxons Implemented in 
IMPRINT

Stressors Taxons

MOPP & Heat Visual

Fine Motor Discrete

Communication (oral)

MOPP & Cold Visual

Fine Motor Discrete

Gross Motor Light

MOPP & Noise Communication (oral)

Heat & Noise Communication (oral)

Heat & Sleepless 
Hours

Numerical

Problem Solving

MOPP & Heat & 
Cold

Visual

Fine Motor Discrete

MOPP & Heat & 
Noise

Communication (oral)
166



Appendix A: Technical Description of Stressor Implementation
findings against eight criteria: configuration management, software 
verification, documentation, data input requirements, model granularity, 
validity of modeling techniques and embedded algorithms, output, and 
analysis timelines. All criteria were satisfied and formal accreditation was 
granted in January 1995 with only limited caveats (see Allender et. al, 
1995).

Since the environmental stressors were transitioned to IMPRINT without 
modification, the basic VV&A transitioned as well. Of note, although this 
portion of the software was approved and the basic approach of degrading 
time and/or accuracy of performance on a task-by-task basis was 
supported, the consensus was that all the algorithms warrant updating and 
that new algorithms need to be developed to fill the voids. Referring to the 
Table A-2, and to the dates of some of the environmental stressor 
references, it is clear that there are substantial voids and that there is 
certainly new research that should be accounted for in this arena.

Examples of the Method for Test and Evaluation

 One example of the implications of this modeling approach to the test and 
evaluation arena was reported by Allender, McAnulty, and Bierbaum 
(1992). They describe the application of the predecessor HARDMAN III 
software to the analysis of potential options for reducing turnaround time in 
an Apache Forward Arming and Refueling Point (FARP). Once the 
baseline was constructed, three options were compared: adding a new 
equipment component, adding personnel, and changing reloading tactics, 
that is full vs. half reload of one ammunition type. The level of effort 
involved in the evaluation of options was only a fraction of the baseline 
development costs and certainly only a fraction of comparable field trials. 
Since the modeling effort was conducted at the same time as the test 
planning was under way, the results were available to the test planners to 
help focus testing and to serve as a validation reference. They asserted 
that the results were appropriate to be used in interaction with testing, not 
as a substitute.

Another example is the work reported by McMahon, Spencer, and 
Thornton (1995). Within months of a final milestone review, an NBC 
reconnaissance system called the Fox had been given an “unacceptable” 
operational assessment at the completion of a large-scale field test. The 
central issue was that a four-seat vehicle had not been modified to fit the 
new three-person crew. The operator was forced to switch positions 
repeatedly in order to do the job, which caused safety problems and 
unacceptable performance. Coupled with modeling of proposed changes to 
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the equipment and display layout, two mission models were built: the 
baseline and the proposed re-design. The mission model predicted 
substantially reduced workload and improved performance. Subsequently, 
the system was retro-fitted for a limited, two-week test which validated the 
model predictions. From this example the time, cost, and even safety 
benefits of using modeling in conjunction with testing are quite evident. 

Proposed Environmental Stressor Developments

The examples provided in the previous section are good evidence for the 
utility of modeling in the test and evaluation arena; however, a 
comprehensive application of the environmental stressors for test and 
evaluation has not been completed. This is clearly a priority. Also, the 
shortcomings, voids, and need for updates to the stressors are obvious. 

At this time, the literature in this area is being re-surveyed in order to 
develop a prioritized list of stressor updates, enhancements, and additions. 
Criteria for the prioritization are user need and availability of generalized 
data. Several other organizations have also identified this type of work as 
critical and plans for leveraging and cooperation are under way. Work of 
note includes that being performed under the auspices of the United 
Kingdom Defence Evaluation Research Agency Centre for Human 
Sciences, the Integrated Performance Modeling Environment. The U.S. 
Defense Special Weapons Agency (formerly the Defense Nuclear Agency) 
has published work in this area also (for example, Anno, Dore, & Roth, 
1996). Close at hand, the U.S. Army Research Laboratory Human 
Research and Engineering Directorate is currently investigating databases 
on various dimensions of psychological stress as related to performance 
for inclusion in IMPRINT.

In conclusion, the IMPRINT tool offers a modeling technology for 
evaluating human performance under diverse conditions. Based on sound 
task analysis, network modeling, and environmental stressor degradation 
algorithms tailored to task type, assessments of performance under 
diverse conditions can be used to augment test and evaluation today. With 
continued development, the capability to perform these types of analyses 
will be further enhanced.
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Micromodels

IMPRINT Pro uses the following types of micromodels:

Perceptual Micromodels

Cognitive Micromodels

Motor Micromodels

Special Micromodels

Perceptual Micromodels

The following table contains the basic parameters for perceptual 
micromodels.

Model Value or Equation Reference

Eye Movement 
Time (target 
located in eye 
field)

100 msec (travel time only) Houtmans & Sanders, 
1984; Sanders & 
Houtman, 1985

Head Movement 
Time (target 
located in head 
field)

200 msec (travel time only) Houtmans & Sanders, 
1984; Sanders & 
Houtman, 1985

Eye Fixation Time 100 msec - 500 msec Houtmans & Sanders, 
1984; Sanders & 
Houtman, 1985

Search Time (Tm + Tf)N where
N = number of fixations
Tm = movement time
Tf = fixation time
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Motor Micromodels

The following table contains the basic parameters for Motor micromodels.

Reading Rate 52 words/min (5 saccades per 
word), 261 words/min (1 
saccade per word), 652 
words/min (1 saccade per 
phrase), Assumes: 5-letter 
words, 2.5 words or 13 
characters per phrase

Card et al., 1983

Listening Rate: 2.4 words/sec Miller and Licklider, 1950

Model Value or Equation Reference

Model Value or Equation Reference

Basic Parameters

Hand Movement (Fitt's 
Law-Welford Variant)

IM log2 [D/S + 0.5] where T = 
Movement Time
 D = Distance between targets
 S = Size of Targets
 IM = Slope Constant =.1 sec/
bit

Welford, 1968

Hand Controls

Pushbutton or Toggle 400 msec Harris et al., 1988

Rotary Dial 730 msec Harris et al., 1988

Cursor Movement with 
Trackball

IM * log2 (d/s + 0.5) where
IM = constant = 100 msec/bit
 d = cursor distance to be 
moved
 s = display symbol width

Harris et al., 
1988, from Fitt's 
Law

Cursor Movement with 
Mouse

1.03 +.06 log2 (D/S +.5) sec
 D = Distance to target
S = Size of target

Card et al., 1983
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Cursor Movement with 
Joystick

KD +.100 log2 (D/S +.5) sec 
where
KD = intercept distance for 
distance D
 D = Distance moved
 S = Size of target

Card et al., 1983

Cursor Movement with 
Step Keys

98 +.074 (Dx/Sx + Dy/Sy) sec, 
where
Dx=Horizontal distance to 
target
 Dy=Vertical distance to target
 Sx=Size of a vertical step 
(default =.456 cm)
Sy=Size of a horizontal step 
(default =.246 cm).

Card et al., 1983

Cursor Movement using 
Text Keys

.66 +.209 Nmin sec. where

.209 = Keystroke rate (in sec/
keystroke) which approximates 
the typing rate for random 
words
 Nmin = minimum number of 
keystrokes.

Card et al., 1983

Single Finger Keying 
Rate

.140 [.060 =.200] sec Card et al., 1983

Typing Rate .209 sec/keystroke Card et al., 1983

Walking Rate 0.19 sec/foot Harris, 1988

Speech

Speech rate 3.4 words/sec (large 
vocabulary)
 2.4 words/sec (small 
vocabulary)

McCormick, 1970

Model Value or Equation Reference
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Cognitive Micromodels

The following table contains the basic parameters for cognitive 
micromodels.

Model Value or Equation Reference

Perceptual Process τP = 100 msec Card et al., 1983

Decision Process τC = 70 msec Card et al., 1983

Motor Process τM = 70 msec Card et al., 1983

Simple Reaction Times - 
On/Off Response

τP + τC + τM = 240 msec Card et al., 1983

Simple Reaction Times - 
Physical Match

τP + 2τC + τM = 310 msec Card et al., 1983

Simple Reaction Times - 
Name Match

τP + 3τC + τM = 380 msec Card et al., 1983

Simple Reaction Times - 
Class Match

τP + 4τC + τM = 450 
msec

Card et al., 1983

Choice Reaction Time K * log2 (n+1) where
k is a constant 
representing simple RT 
and is set at 150 msec.
n is number of possible 
alternatives

Hick's Law as discussed 
in Card et al., 1983

Mental Rotation 
(Visualization)

1 sec + (R / 50o per sec) 
where: 
R = amount of rotation 
from initial perceived 
view to final visualized 
view (in degrees)

Shepherd and Metzler, 
1971
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Special Micromodels

The following table contains the basic parameters for special micromodels.

Model Value or Equation Reference

Prioritization (that 
is, of targets)

.310[n(n+1) / 2] where: 
n = number of targets in a sector. 
This formula treats prioritization 
as a unidimensional [worth] 
pairwise comparison between all 
possible targets in a sector.

McCarthy and Plocher, 
1990

Terrain 
Association

Two stage process:
Stage 1. Reduce size of area of 
uncertainty: Time = 5 sec. 
(Performed once every time a 
completely new view is 
encountered.)
 Stage 2. Pinpoint own location 
Time = 2 sec. Per terrain 
matching attempt. (Four to seven 
matching attempts required to 
pinpoint own location. Other job 
activities are typically 
interspersed in between terrain 
matching attempts.)

Cross, Rugge, and 
Throndyke, 1982
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Appendix C: Impact of Training and 
Personnel Characteristics on Taxons

The following tables describe the impact of Training Frequency and 
Personnel Characteristics on Taxons in IMPRINT Pro.

Table C-1 details which task taxons are affected by changes in ASVAB 
cutoff scores in the current IMPRINT software. It also shows whether the 
task performance is degraded by time, accuracy, or both. Since 
degradation factors are processed as multipliers, the degradation factors 
affecting time will be greater than 1.0 to increase the performance time. On 
the other hand, the degradation factors affecting accuracy will be less than 
1.0 to decrease the performance accuracy from the pre-existing accuracy 
level. The overall degradation resulting from a specified cutoff score is 
directly proportional to the weighting assigned to the affected taxon(s) 
comprising the task. 

Table C-2 details which task taxons are affected by changes in Training 
Frequency in the current IMPRINT software

Table C-1: Listing of the IMPRINT Taxon Types Affected in Either Time or 
Accuracy or Both by changes in ASVAB scores 

Taxon Increase/Decrease of ASVAB

Visual  A

Numerical T/A

Cognitive T/A

Fine Motor 
Discrete T/A

Fine Motor 
Continuous

Gross Motor Light  A 

Gross Motor 
Heavy

Communication 
(Read & Write) T/A

Communication 
(Oral)  A
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where T = Affects task time only

A = Affects task accuracy only

TA= Affects task time and accuracy

Table C-2: Listing of the IMPRINT Taxon Types Affected in Either Time or 
Accuracy or Both by Training Frequency.  

where T = Affects task time only

A = Affects task accuracy only

TA= Affects task time and accuracy

Taxon

Less 
than 

twice a 
year

Less 
than 

once a 
month

Once a 
month 

(default)

2 or 3 
times 

a 
month

Once 
or 

more a 
week

Visual    

Numerical T/A  T/A T/A T/A T/A

Cognitive  A TA

Fine Motor 
Discrete  A  A  A A A

Fine Motor 
Continuous

Gross Motor 
Light  T  T

Gross Motor 
Heavy

Communication 
(Read & Write) T/A  T/A T/A T/A T/A

Communication 
(Oral)    
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Appendix D: Local Server and Remote 
Server Setup

After installing IMPRINT Pro and its supporting applications, you may start 
to add and import analyses to work on as desired. Before beginning any 
analysis work in IMPRINT Pro, however, we recommend that you first 
check your settings for your local server where your analyses will be saved. 
You may also optionally set your system up to work with a remote server in 
order to access files from a networked computer running the same version 
of IMPRINT Pro. This section discusses the advantages of each server 
environment and the setup required.

Local Server Environment vs. Remote 
Server Environment

When loading, creating, modifying and saving analyses in IMPRINT Pro, 
you have the option of working with files which are local to your own 
machine (local server) or those which are located on a remote machine 
(remote server). Files which are local to your own machine may be 
accessed, loaded, run and saved without any special configuration, 
although there are settings available to you that you may choose to modify 
at a later point. Files which are accessed remotely may only be done so 
once a connection has been established with a remote server. This remote 
server may be another user’s machine or a literal server on a network 
which is accessible by several machines on the network. 

Access to files via a remote server first requires creating a group on the 
remote machine which defines all IMPRINT Pro users who will have 
access to shared IMPRINT Pro files. If a group is not used, then access 
must be set up on the remote server for user accounts on an individual 
basis. Secondly, the group (or individual user accounts) must be given 
permission on the remote machine to access and modify remote files. 
Third, the local machine must be configured to connect to the remote 
server. For more information see “Step 1: Allowing Remote User Access 
on the Remote Server Machine” on page 182.
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Once the setup is complete, you may access analyses for either of these 
servers through the IMPRINT Pro interface. Upon launching IMPRINT Pro, 
the server nodes immediately appear in the Analysis Tree as two folder 
nodes: Local Server and Remote Server. These nodes represent the 
local server directory and the remote server directory where you may 
access and store your analyses.

Because files in the remote server environment are shared between two or 
more users, IMPRINT Pro includes an option to lock any files you (as a 
local user or remote user) check out and wish to modify in order to 
guarantee that your modifications to the file can be saved back to the 
remote server database. For more information on locking files see “Viewing 
Analyses in the Local and Remote Servers” on page 189.

Once your remote server option is configured, you may select any 
unlocked analysis and do the following:

View the analysis remotely (i.e., view the network diagram, view 
tasks)

Run models from the analysis remotely

Copy a remote analysis and paste it into your local directory

Coping parts of the remote analysis (missions, tasks, etc.) and 
pasting these parts into an existing analysis or new analysis on 
your local machine

Modify and save changes to the analysis (not to include cutting, 
deleting or updating any part of a remote analysis)

Create new folders on the remote server

Create new analyses on the remote server

The following actions are prohibited for a remote user accessing a remote 
server:

Deleting an analysis on a remote server

Cutting any part of an analysis on a remote server (i.e., cutting 
missions, tasks, etc.)
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Updating any remote analysis to a newer version of IMPRINT 
Pro 

Setting Up the Local Server Directory
The Local Server settings window available through the IMPRINT Pro 
interface displays the location where your IMPRINT Pro data is stored 
locally. This location is a fixed folder on your machine and cannot be 
modified. 

To view the local connection setup from the local machine

1. Open IMPRINT Pro.

2. Locate the Local Server node in the Analysis Tree. Double-click this 
node.

The Local Server dialog displays the IMPRINT Pro Data Folder. The 
folder specified in this path is the location where all analyses in 
progress (IMPRINTProData.ipa files) and the IMPRINT Pro directory 
(IMPRINTProDirectory.ipd file) are stored. The local server defaults to 
the following path depending on your system’s operating system:

Windows XP:
C:\Documents and Settings\[user]\Application Data\Alion Science and 
Technology - MA&D Operation\IMPRINT Pro\Data

.

Windows Vista:
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C:\Users\[user]\AppData\Roaming\Alion Science and Technology - 
MA&D Operation\IMPRINT Pro\Data

Note:
The default Local Server path is not changeable by users nor by 
administrators.

Setting Up the Remote Server Directory
Setting up the remote server directory requires three steps:

1. Defining a new group on the remote server to include all remote users 
who wish to access the remote server machine.

2. Configuring the remote server to allow a defined group of remote 
IMPRINT Pro users or individual users access to a shared folder.

3. Configuring the local machine to access the remote server.

Step 1: Allowing Remote User Access on the Remote 
Server Machine
The first step in setting up the remote server directory is to create a group 
on the remote machine to which all the remote users will belong. Privileges 
may then be assigned to the group as a whole, omitting the need to assign 
privileges to users on an individual basis. These privileges will allow any 
remote user who is set up to be part of the group to connect to the remote 
server and to access shared IMPRINT Pro analyses. 

This setup, however, does not require that the user have sysadmin 
privileges to the machine.

Note:
Although the Delete permissions are required for the remote user login, they 
do not permit a remote user to delete remote server files.

For convenience, the permissions are assigned to the Group level in the 
steps below. You may, however, assign the same permissions on a 
per-login basis if you choose.

To define the remote user group on the remote server machine:
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4. Right-mouse click the My Computer icon on your desktop and select 
Manage

.

In the tree, select Local Users and Groups.

OR

From the Start key, select Settings Control Panel  User 
Accounts.
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In the dialog which appears click the Advanced tab, and then click the 
Advanced button under Advanced User Management.

The Local Users and Groups dialog appears.
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5. Right-mouse click the Groups folder, and select New Group from the 
shortcut menu which appears.

In the New Group dialog, provide a name and description for the new 
group.

6. Click the Add button.

From the Select Users, Groups or Computers dialog, specify the 
name of the user who will be connecting to this server remotely, and 
then click OK.

7. Click the Create button.

The new group appears in the Groups list in the Computer 
Management window (or Local Users and Groups window).
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Step 2: Allowing Remote User Access to the IMPRINT 
Pro Database
Once the group is defined on the remote server machine and the user(s) 
are assigned to it, permissions must then be set for the common folder on 
the remote server to allow a remote user to read, write to and modify data 
in the database. This setup, however, does not require that the user have 
sysadmin privileges to the machine.

To allow remote user access to the IMPRINT Pro database:

1. Locate the folder on the remote server machine to serve as the 
common folder for all shared analyses.  This folder should be the 
location where all analyses in progress (IMPRINTProData.ipa files)  
and the IMPRINT Pro directory (IMPRINTProDirectory.ipd file) are 
stored. The local server defaults to the following path depending on the 
operating system:

Windows XP:
C:\Documents and Settings\[user]\Application Data\Alion Science and 
Technology - MA&D Operation\IMPRINT Pro\Data

Windows Vista:
C:\Users\[user]\AppData\Roaming\Alion Science and Technology - 
MA&D Operation\IMPRINT Pro\Data

Note:
The default Local Server path is not changeable by users nor by 
administrators.
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2. Set the folder’s permissions such that all users, either via a group or 
individually, have “Full Control”.

Note:
For Windows XP: although the Delete permissions are required for the remote 
user login, they do not permit a remote user to delete remote server files.

Step 3: Configuring the Local Machine to access the 
Remote Server

To configure the local machine to access the remote server

1. Open IMPRINT Pro on the Local machine.

2. In the Analysis Tree, double-click the Remote Server node.

The Remote Server dialog displays.

3. Next to the IMPRINT Pro Data Folder field, click the Browse... button. 

The Browse For Folder dialog appears.

4. Browse to the designated shared IMPRINT Pro data folder.  This 
remote server path must point to the location on the remote machine 
which contains all analyses in progress (IMPRINTProData.ipa files)  
and the IMPRINT Pro directory (IMPRINTProDirectory.ipd file).  The 
default location of these files on the remote machine’s directory 
depends on the operating system:

Windows XP:
 C:\Documents and Settings\[user]\Application Data\Alion Science and 
Technology - MA&D Operation\IMPRINT Pro\Data.

Windows Vista:
C:\Users\[user]\AppData\Roaming\Alion Science and Technology - 
MA&D Operation\IMPRINT Pro\Data
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5. Click the OK button

The path to the selected folder appears in the IMPRINT Pro Data 
Folder field.  You are now ready to view/access analyses on the remote 
server through IMPRINT Pro.  The path as it appears in the field may be 
abbreviated if the folder specified is already shared on your network.

If the path entered in the IMPRINT Pro Data Folder field is invalid, a 
message appears below the field, indicating the path is invalid.  

In this case verify the machine name and path entered in the Remote 
Server dialog. Next, check with your network administrator to verify the 
correct privileges have been set for your login on the remote server 
machine. Finally, check to make sure the remote server machine is 
turned on.

Viewing the Server Directories in the IMPRINT 
Pro Analysis Tree

The highest level nodes in the Analysis Tree are the Local Server node and 
the Remote Server node. These nodes represent the local server directory 
and the remote server directory where you may access and store your 
analyses.
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When starting up IMPRINT Pro, the Local and Remote server nodes 
immediately appear in the Analysis Tree.

Viewing Analyses in the Local and Remote Servers
To view analyses in the local and remote server environments:

1. Click the plus “+” sign next to the Local Server and/or Remote Server 
node(s).

A list of folders containing your analyses appears.

2. Click the plus “+” sign next to a folder.

A list of analyses within the folder appears.
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Locking and Unlocking Analyses
When using the remote server option in IMPRINT Pro, access to analyses 
is shared between two or more users. This provides the benefit of allowing 
several users access to the same analysis without having to export and 
import the analysis from machine to machine.

To prevent two or more users from accessing the same analysis at the 
same time and potentially overwriting each other’s changes, you may first 
lock the analysis. The lock option allows you to open, modify, run and save 
the analysis as you choose while allowing other users limited privileges of 
viewing a copy of the analysis in its last saved state. When you have 
completed and saved your changes to the analysis, you may then unlock 
the analysis for other users to be able to access and modify your updated 
file as required.

To lock an analysis:

1. Right-click the desired analysis in the Analysis Tree.

From the shortcut menu that appears, select the Lock Analysis option.
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2. The blue lock symbol appears next to the analysis name in the tree.

To unlock an analysis:

1. Right-click the desired locked analysis in the Analysis Tree.

From the shortcut menu which appears, select the Unlock Analysis 
option.

The blue lock symbol disappears from the analysis name in the tree, and 
the analysis is once again fully accessible by all other remote users.

Note:
Prior to unlocking the model, you will be prompted to save your analysis 
if your model has any changes which have not been saved.

The following conditions should also be considered when locking and 
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unlocking analyses:

If another user has a lock on the model, a message appears both 
before the model run and before attempting to run reports that 
reports are unavailable. This is because you do not have the lock 
thus you cannot save model run data to the database for the 
reports to be able to utilize. 

If you have the lock and choose to unlock the analysis, every 
time you run the model the analysis will be re-locked. This is 
because IMPRINT Pro needs to ensure that data from the model 
run can be saved to the database, which requires a lock. 

Closing the analysis (using the actual Close Analysis shortcut 
option to do this) will result in the lock being released. 

Collapsing the analysis in the tree does not result in the lock 
being released. 
192



Appendix E: IMPRINT 7 to IMPRINT Pro 
Conversion

IMPRINT Pro is based on the IMPRINT 7 tool but has been completely 
redesigned to be faster, modular, and more powerful.  The following list 
describes areas in IMPRINT Pro which have been significantly enhanced 
since IMPRINT 7:

New docking interface allows you to place windows where they 
are most useful.

Highly configurable windows that allow you to reposition 
windows into logical working groups and to temporarily hide 
windows that you are not using.

Analysis Tree view that displays a list of all analyses.

Task network palette that contains the tools you use to construct 
the task network.

An Output window that displays the trace of execution, including 
the clock times for events, application errors, whether plugins 
were loaded successfully, the start and end of simulation, and 
any syntax errors.

A Properties window for all the model items that displays a list of 
all the item properties. Properties can be changed directly in the 
Properties window or in the associated dialog box for any model 
item.

Multiple charts that can be used to plot variable data as a 
function of the clock time or as a function of another variable.

Enhanced functionality on the task network diagram, including 
Groups (collections of similar tasks that resemble a network and 
can be minimized) and Comments (the display of text or the 
values of variables during execution).

Ability to export all model items in HTML format and all data files 
in .xml format.

IMPRINT 7 to IMPRINT Pro Conversion List

The following list describes the differences between IMPRINT 7 and 
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IMPRINT Pro:

IMPRINT 7 IMPRINT Pro

Installation

Installs to C:\IMPRINT 7 Installs to C:\Program Files\IMPRINT 
Pro

Database

Requires that MySQL 3.23.58 be 
installed prior to installing 
IMPRINT 7.

Requires the latest version of MSDE (Microsoft 
Database Engine).

Analyses stored as .imp folders in 
C:\MySQL\Data.

Analyses stored in the MSDE database.

Import and Export

Files in IMPRINT 7 export as .xch 
for use on other IMPRINT 7 systems 
and export to .7XP (xml file) for 
import into IMPRINT Pro.

IMPRINT Pro imports .7XP from IMPRINT 7 
and exports to .pro for use on other 
machines having Pro.

Terminology

“MOS” Changed to “Specialty”

“Crewmembers” Changed to “Warfighters”
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Difference in Analysis Setup

Operators are attached to a Mission.

Crewmembers are defined through 
the Mission page, and all appear 
under one list.

MOS types must be added prior to 
being available when defining 
Crewmembers.

Operators are attached to an Analysis (under 
the Warfighters node just below the Analysis 
level.)

Warfighters (previously Crewmembers) are 
added through the Warfighters node and are 
separated into three distinct categories: 
Operators, Maintainers and Supply and 
Support Personnel. Only Operators have 
names associated with the chosen Specialty 
whereas Maintainers and Supply and Support 
Personnel are listed as Specialty only.

Specialty types (previously MOS) may be 
defined at the time the Warfighter (previously 
Crewmember) is defined.

RI pairs are found only in Advanced 
models; see Options–Workload and 
Crewstation Parameters–Define 
Resource Interface Channels.

RI pairs available for all analyses; see RI pairs 
node under the Mission node for your mission.

Each task for each operator must 
have at least one RI pair attached to 
it; see Assign R/I Channels to Tasks.

RI pair assignments are optional for each task.

Access Demand values through 
Options–Workload and Crewstation 
Parameters–Assign Single Task 
Demand Values.

Double-click the Network node, click the 
Review Tasks tab, and then click the Task 
Demands option. This option is also available 
under the Workload Demand tab for any task.

Crewmembers defined and Assigned 
by Mission.

Warfighters (previously Crewmembers) now 
defined at the Analysis level; all Warfighters 
available to all missions within that analysis.

IMPRINT 7 IMPRINT Pro
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Data Loss

RI pairs are assigned to each task, 
for each operator.

Pro only imports the RI pairs from the 
IMPRINT 7 model which were assigned to the 
lowest operator ID.

Two Crewmembers might share the 
same task having the same RI pair. 
Each might have a different demand 
value assigned for that task. For 
example, “Listen to Radio” might 
require an Auditory/Crewstation 
demand value of 5.00 by Driver and 
3.00 by Navigator.

If Driver was created first, then the “Listen to 
Radio” task has a generic Auditory/
Crewstation demand value of 5.00 regardless 
of Operator.

IMPRINT 7 IMPRINT Pro
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